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1. Introduction 

List of key BioStation Viewer features: 

 

1) Visualize molecular structures of Protein and DNA 

2) Visualize isosurface of electron density, electrostatic potential and molecular 

orbitals. 

3) Visualize isosurface of the electron density, added colors by the value of electrostatic 

potential. 

4) Edit molecular structures 

5) Visualize the interaction energy between fragments 

6) Visualize Electron Field Vector 

7) Animate molecular trajectory 

 

Fig1.1 shows an example of isosurface of electron density, added colors by the value of 

electrostatic potential 

 

Fig1.1 Isosurface of Electron Density, Added Colors by the Value of Electrostatic 

Potential  
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2.  How to use BioStation Viewer 

 

2.1. Getting Start BioStation Viewer 

Double click on the icon of the desktop to start Viewer. Fig2.1 shows the main 

window.  Molecular structures are shown on the hierarchical window on the left side of 

the window and on the viewing-window by a 3-dimensional image (3D) on the right. You 

can choose display option from the menu bar. The hierarchical window shows a 

tree-view of the molecule, the layer of molecule by chains, residues and atoms.  By 

selecting an icon in hierarchical item, the appropriate atom in 3D view-window is 

highlighted.  By selecting the displayed structure in 3D view-window, the appropriate 

items in hierarchical window are highlighted.  The message appears at the bottom of 

the window. 

  

 

Fig2.1 Main Window 
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2.2. Explanation of Menu 

 

Fig2.2 Menu at main window 

2.2.1. File 

 

Fig2.3 File menu 

 Open Load PDB file(*.pdb,*.ent) 、 ABINIT-MP Check Point File(*.cpf) 、

ABINIT-MP Grid File(*.den,*esp,*.map,*.mo) 、 MOL2 file(*.mol2) 、 MDL 

file(*.mol, *.mdl) and Gaussian Cube file(*.cube,*.cub), XYZfile(*.xyz), 

Trajectory file (*.trj,*.tr2,*.trj2,*tj2), Pno file(*.pno), Display profile（*.prof）. 

Please refer to the specification of each file from the following URL. 

 ABINIT-MP : http://www.fsis.iis.u-tokyo.ac.jp/result/software 

 PDB File： http://www.rcsb.org/ 

 MOL2File： http://chemyang.ccnu.edu.cn/ccb/server/AIMMS/mol2.pdf 

MDL File：  

 Gaussian Cube File： http://www.gaussian.comの G98 Manual Pages 

 XYZ File：Describe number of atom at first line, comment line, and atom 

symbol, x,y,z coordinate in one line. As extension, in BioStation Viewer, the 

vector values of x, y and z is specified behind coordinates, and the vector 

http://www.fsis.iis.u-tokyo.ac.jp/result/software
http://www.rcsb.org/
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display for every atom is possible. Refer to the Arrow of Preference 

specification for change of the display attribute of a vector. 

 Mopac input/output file: Dewar, M.J.S., Thiel, W., J. Am. Chem. Soc., 1977, 

99, 4899, 3907 

 Trajectory File : refer 2.4.1 

 Pno file : http://www.fsis.iis.u-tokyo.ac.jp/result/software 

 Display profile : you can reproduce the display state by saving in the file 

and reading the file. The corresponding functions are shown bellow. 

 Include 1 of CPF or PDF. The other structure files are not supported 

 View Point 

 Model 

 Color 

 Atom,Residue (Model,Color,Label) 

 Tool(Display * in Distance, Set Rotation Center ) 

 Monitor(Distance, Angle, Dihedral Angle, Interaction Energy, IFIE 

1:1,N:1 

 Preference 

   

1) Molecular Structure file 

When PDB file、ABINIT-MP Check Point File、MOL2 file, MDL file, XYZ file, 

Gaussian output file and Mopac input/output file are loaded, the molecular 

structures are displayed. When number of atom lower than 300, display slyle is 

Stick, more than 300 is CA (Line).  

 

2) ABINIT-MP Grid File, Gaussian Cube File 

The extension of ABINIT-MP Grid File means as follows :   

  i) den :   electron density 

  ii) esp :   electrostatic potential  

  iii) map :  map file of electrostatic potential on the isosurface of the electron 

    density.  

  iv) mo :   molecular orbitals  

  v) efv :   electron field vector 

When ABINIT-MP Grid File loaded, specify the isosurface value that you want 

to visualize. 

In the case of a Gaussian Cube file, select the file type from electron density, 

electrostatic potential, and a molecular orbital, and specify covering a value of 

http://www.fsis.iis.u-tokyo.ac.jp/result/software
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the boundary on a periodic display, and performs the display specification of 

each. Periodical grid value is selected “On” for add one a cell at edge of boundary, 

set “Off” that not add a cell. A dialog box shown in Fig2.4. 

 

Fig2.4  Gaussian Cube File 

3) Specify electron density display option 

 A dialog box for the electron density and electrostatic potential is shown in 

Fig2.5. Specify the value of the isosurface value, the color, the transparency, 

bounding box and section. There are the two methods of coloring. One is to 

specify a single color and the minimum value and maximum are specified, a 

color is specified in the range. The Color Preference Dialog Box is shown in 

Fig2.6. 

There are two types specify of isosurface value a value or sigma. σis calculated 

by following equation. If the value is more than 1, it is treated as 1. 

σ[ρ] = [
∑ {𝜌(𝑥𝑖 , 𝑦𝑖 , 𝑧𝑖) − �̅�}𝑁
𝑖=1

2

𝑁
]

1/2

 

 Clicking on the “Set” button , display section specify dialog. Refer to Section 2.3 

to set section option.  

This sigma function is currently suspended. 
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Fig2.5 Isosurface Value Dialog Box 

 

Fig2.6 Color Preference Dialog Box 

4) Specify map file and electrostatic potential 

In the case of a map file, specify the ranges of both the value of the isosurface 

value and that of electrostatic potential.  This dialog box is shown in Fig2.7. As 

the value of the default is changed from high to low, the visualize color is 

changed from red to white to blue.  When you set Min Max( red, blue) using the 

button for specifying the range of the value, the display color is changed from 

blue to white to red.  

 In the case of electrostatic potential, specify the value of the isosurface value.  
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The isosurface value is displayed by the two specified values(±). 

  

Fig2.7 Map file and Electrostatic Potential Dialog Box 

5) Specify display option of Molecular Orbital 

In the case of the molecular orbital, the orbital energy graph is displayed. The graph 

window is shown in Figure 2.5.   When you move the mouse on each level, the orbital 

number and the energy value are displayed under the graph.   When you click on each 

level, the orbital number is selected in the Mo No.  Here the orbital number can be 

input directly. When you click on the  Draw button,  visualize the isosurface of the 

specified value (±).  

By clicking on ”＋” and”－“ buttons,  the graph is scalable.  The line width each level 

can be specified with Line Width.  Colors of the isosurface value can be specified in the 

optional colors dialog box.  In addition, Color(-,+) can be changed into Color(+,-), and 

the colors will be reversed whenever they are selected.  

In Gaussian Cube file, without the energy value, the graph is displayed starting from 

1, in the case of the descriptions of multiple orbitals.  
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Fig2.8 Graph window of Isosurface of Molecular Orbital .

6) Specify display option of electron field vector  

When a electron field vector file loaded, a dialog box(Fig2.9) pops up and  

displays an electron field vector by the defaults option. An electric field vector 

is displayed on the basis of the point on isosurface. Display option is explained 

below. 
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Fig2.9 Electron Field Vector Dialog Box 

 Map Property 

 Value of Density Isosurface 

Specify the value of density Isosurface 

 Min Max(blue,red)/ (red,blue) 

Specify the range of electrostatic value. As the value of the default is 

changed from high to low, the visualize color is changed from red to white 

to blue.  When you set Min Max( red, blue) using the button for 

specifying the range of the value, the display color is changed from blue 

to white to red.  

 Transparency 

Specify the Transparency 

 Bounding Box 

Specify to display a bounding box. 

 Section 
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Clicking on the Set button, display the dialog box for a section view. 

Refer to Section 2.3 to set the section options.  

 Electric Field Vector Property 

 Model 

Specify the model (Line/Stick). When the stick model is selected, specify 

the radius of stick. 

 Start Value Threshold(min,max) 

Specify the start point range of electrostatic value on the isosurface 

 Number of Step 

Specify the number of step. It repeatedly calculates the specified number 

of times, and a vector is displayed.  

 Length(Å) 

Specify the length of one step. 

 Thinned-out ratio (0.0-1.0) 

Specify the thinned-out ratio of start point. (value range : 0-1) 

 Draw  

   Display electron field vector. 

    

7) Trajectory file 

Animate the molecular structure in time series. Refer to Section 2.4 for 

details. 

 

8) Pno(Pair Natural Orbital) file 

Display isosurfaces of Pair Natural Orbital. Specify display option for each pair 

orbital. Display each relaxation energy, occupation number of Hole orbital and 

Particle orbital. You can specify display on/off each item. The vector is a arrow 

from Hole grid region to Particle grid region.  All pairs can be 

selected/unselected by “Select All/Unselect All” Button. When a “Apply” button 

is clicked, it's displayed by the specified style.  A dialog box shown in 

Fig2.10,Fig2.11. 
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Fig2.10 Pno(Pair Natural Orbital) Dialog Box 

  

Fig2.11 Hole, Particle,Vector Dialog Box 
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 Open CPF  

You can specify fragments that are subject to display at open dialog. Only the 

specified fragments are displayed. Non-display specified fragments are not 

displayed unless you re-read them. There are four modes. 

1) None : It is displayed without any specification. 

2) Ignore Fragments : Specify fragment numbers that are not subject to 

display 

3) Fragments in Distance : Display a fragment within the distance from the 

specifier fragment. 

4) Ignore Fragments by dimer value(CPF R23) : Do not display fragments 

that are not have dimer value. 

 

Fig2.12 Open CPF Dialog Box 

 

Fig2.13 Exanple of None. 
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Fig2.14 Example of Ignore Fragments 

 

 

Fig2.15 Example of Fragments in Distance 
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Fig2.16 Example of Ignore Fragments by dimer value(CPF R25) 
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 Open File[difference density]  

Some Grid files are loaded and the isosurface of difference is displayed. If you 

specified different grid size data file, error occurred. The maximum number of 

files is 7. The dialog box is shown in .Fig2.17.  

 

Fig2.17 Difference files Dialog Box 

 Open File[difference cpf] 

Some Check Point files are loaded and calculate charge and IFIE. The dialog 

box is shown in Fig2.18.  

Adjust Atom Range : Specify a part of atoms in file that are calculated. 

Format : Start atom No. – End Atom No. Corresponding atomic number in 

this file.  

Ex. File2 “10-20 5” atom No.10-20 in file1 correspond to atom No.5-15 in file2. 

If no specify atom No., all atoms correspond. If selected “Coddinate”, Display 

atom No. in this line file. 

 

Fig2.18 Check Point Files Dialog Box 
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 OpenFile[Supermolecule]  

Specify complex, protein and ligand CPF file. The dialog box is shown in 

Fig2.19. The fragment number of the protein in a complex is specified like this 

“1-100”.  Clicking on the Ok button, read files and display the IFIE value 

which applied electronic relaxation by ligand binding at 3D List and MAP.  

 

Fig2.19 Supermolecule Dialog Box 

 

 Save File 

You can output each file by selecting the extensions.  

1) pdb, ent  Save molecular structures by PDB file format.  

   Atomic numbers in the saved files are renumbered.  

2) gjf  Output the input file of Gaussian.  Here is an example of file. In the 

case of a display of ABINIT-MP Check Point File, charged molecules and spin 

multiplicities are calculated as follows.  

 Charged molecules = the sum of charged molecules (the sum of nuclear  

numbers ) – the sum of electron numbers of fragments.  

    Spin multiplicity = If the first letter of an electronic state is S, show 1,  

if it is D, show 2, and if it is T, show 3.  

 

%chk=test.chk 

#HF/6-31G(d,p) POPT=(MaxCycle=100) SCF=TIGHT 

 

 

 0 1 

  N  0 x001 y001 z001 

  C  0 x002 y002 z002 

  C  0 x003 y003 z003 

…………… 

  H  0 x071 y071 z071 

  O  0 x072 y072 z072 

  H  0 x073 y073 z073 

 Variables :  

 x001=  0.162000 
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 y001= -0.202000 

 z001=  0.000000 

 x002=  1.612000 

…………… 

z072= -5.671000 

 x073= -4.846000 

 y073= 12.697000 

 z073= -6.024000 

 Constants :  

3) jpg  Output the JPEG file. 

4) png  Output the PNG file. 

5) tif Outpur the Tiff file. 

6) xyz Output XYZ file. It describes number of atom at first line, and atom 

symbol, x,y,z coordinate in one line. 

7) prof  Output display profile file. 

 

 Save Renumbered PDB  

Save PDB File which renumbered atom number. File name is 

xxx-renumbered.pdb. Specify output “TER”(end of chain) and chain names. 

 

 

 Ｅｄｉt ABINIT-MP File  

Popup the edit window of ABINIT-MP input file.  Here, you can set the 

parameters, load and save files.  How to edit parameters is explained in 

Section2.8.  

 Ｅｄｉt Gaussian Input File 

Popup the simple edit window of Gaussian input file.  Here, you can set the 

parameters, load and save files. 

 Ｅｄｉt cpf2den Input File 

Popup the simple edit window of cpf2den input file(Fig2.20). Here, you can set 

the parameters, load and save files. If loaded Check point file, set the file name 
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and the value applied to maximum and the minimum value ±2A is displayed at 

the column of Domain computing lattice point. Refer to the "ABINIT-MP user’s 

manual" for the details of cpf2den. 

 

Fig2.20 cpf2den input file edit window 

 Mo File(*.mo) 

Specify YES/NO to output the Molecular Orbital grid file.  

Reagion : Specify the fragment number. Ex ：’1,2,8-12’ 

Level : Specify the level of MO. There are some methods shown below. 

・Around HOMO-LUMO ： Ex ’ Homo-5:Lumo+5’ 

・All Orbital：’All’ 

・All occupied Orbital ：’Occ’ 

・All un occupied Orbital：’Virtual’ 

・Orbital number ： Ex ’1-10’ 

 Electron Density File(*.den) 

Specify YES/NO to output the Electron density grid file.  

 Electrostatic Potential File(+.esp) 

Specify YES/NO to output the Electrostatic potential grid file. 

 Map File(*.map) 

Specify YES/NO to output the map file. 

 Electric Field Vector File(*.efv) 
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Specify YES/NO to output the Electric Field Vector File. 

 Pair Natural Orbitals(*.pno) 

Specify YES/NO to output the Pair Natural Orbitals file. 

 Partial Grid 

Specify YES/NO to output the Partial Grid file. NO : calculate all 

molecular.  

Reagion : Specify the fragment number.  Ex. ：’1,2,8-12’ 

 Auto Grid 

YES/No : Calculate grid size based on Grid Delta Size and Grid Box 

Space  

Boundary how/Hide : Specify display boundary. 

Grid Delta Size : Specify a grid size. (Unit is Å)  

Grid Box Space ： Calculate grid size from molecular size and Grid Box 

Space is shortest distance from box to the molecule of edge. (Unit is Å) 

NO : Specify number of x, y and z grid, and coordinate of start and end 

point. Dialog is shown bellow. 

 

 CNS formatted Electron Dnty(*.cns) 

Specify YES/NO to output the CNS file. 

 Restart from file 

Specify YES/NO to output the restart file. 

 Base Name 

Specify base name for output grid file. if do not specify it, use input file 

name as base name.  

 

 Molda  

Execute Molda. Please refer to the manual of Molda for the useage of Molda.  

 Molda(with file)  

Execute Molda with loaded structure file. 

 File List  
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When multiple files are loaded, select the file, which you want to display.  File 

list dialog box is shown in Fig2.21.  In the case of ABINIT-MP Grid File, by 

clicking on Value button, the dialog boxes as Fig2.5, Fig2.7, Fig2.8 and Fig2.9 

are displayed, the display option can be modified. 

 

 

Fig2.21 File List   

 Close File List  

You choose the check box and click on Ok in order to delete the display file on 

the Viewer.  This dialog box is shown in Fig2.22. 

 

Fig2.22 Select Delete Display File 

 Exit   

Exit this application. 
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2.2.2. Viewpoint  

 

 

Fig2.23 Viewpoint menu 

Move a viewpoint to the set-position. Fig2.24 shows a coordinate system. 

 

 

 

 

Fig2.24 Coordinate system  

 Front :  See the front side( from plus direction on the z-axis ) 

 Back  :  See the back side( from minus direction on the z-axis) 

 Left   :  See the left side( from minus direction on the x-axis) 

 Right :  See the right side ( from plus direction on the x-axis ) 

 Top   :  See the topside ( from plus direction on the y-axis) 

 Bottom :  See the downside ( from minus direction on the y-axis)  

 Rotate X :  Rotate around the X axis 

 Rotate Y :  Rotate around the Y axis 

 Rotate Z :  Rotate around the Z axis 

 Rotation/Translation/Magnify :  

   Move the viewpoint position. The Dialog is shown in Fig2.25 and display 

specification is explained below.  

 

x 

y 

z 
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Fig2.25 Rotation/Translation/Magnify Dialog Box and file menu 

 File : Load and save a viewpoint position. The file extension is *.pos. 

 Open ViewPosition File : Load file. 

 Save ViewPosition File : Save file. 

 Rotation  

 Axis : Specify axis. 

 Angle : Specify angle. 

 Translation  

 X,Y,Z : Specify rach distance of x,y and z directions. 

 Magnify  

 Scale : Specify ratio. 

   

 Periodic : Function of periodic display. Only the number specified in X, Y and Z 

directions displays the same thing. The dialog box is shown in Fig2.26 and the 

display specification is explained below. 

 

Fig2.26 Dialog Box of periodic display（example of Gaussian Cube file） 
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 File 

 Reset 

Reset display. 

 Close 

Close dialog. 

 X ,Y, Z 

Specify the number of each direction and interval. In case of Gaussian 

Cube File you specify three values. 

 Draw 

Display periodically.  

 

2.2.3. Model 

Model menu consists two parts (Atom/Structure). 

 

Fig2.27 Model(Atom) menu 

Atom menu 

 Off : Disable to display 

 Wire frame :  Molecule appears as a wire frame model. 

 Wire frame(with fragment bound) : Molecule appears as a wire frame model,  

   with a ball on Catom to show the fragment bound 

 Ball & Stick :  Molecule appears as a ball & stick model 

 Stick       :  Molecule appears as a stick model 

 Ball & Wire: Molecule appears as a ball & wire model 

 CPK       : Molecule appears as a space filling model 

 Backbone : Backbone appears as a tube model 

 C [line]  : Display C atom with a line by a spline interpolation 
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Fig2.28 Model(Structure) menu 

 

 

Structrue menu 

 Off : Disable to display 

 C : Display Catom with a straight line 

 C [line]  : Display C atom with a line by a spline interpolation 

 C [tube] : Display C atom in the tube model by a spline interpolation.  

 Line Ribbon : Display Ribbon(Line) 

 Flat Ribbon : Display Ribbon(Flat) 

 Solid Ribbon : Display Ribbon(Solid) 

 Cartoon Ribbon : Display Cartoon 

 

Example of ERE_EST.cpf is shown in Fig2.29-Fig2.35. 
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Fig2.29 Cα 

 

Fig2.30 Cα Line 
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Fig2.31 Cα Tube 

 

Fig2.32 Line Ribbon 
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Fig2.33 Flat Ribbon 

 

Fig2.34 Solid Ribbon 
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Fig2.35 Cartoon 

 

1) display type of hidrogen 

 

 

 All display all. 

 Polar display hydrogens that connected N. 

 Non Polar display hydrogens that connected except N. 

 No No display. 
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2.2.4. Color 

Color menu consists two parts(Atom/Structure). Atom and Structure menu has the 

same item. The default value is Atom:Atom, Structure:Structure 

 

Fig2.36 Color menu 

 Atom    Set colors by atoms  

 Residue 

 Name Set colors by the residue name, in case of DNA by four kind of colors 

ATGC 

 Hydrophilic/Hydrophobic Set colors by Hydrophilic（  ）/Hydrophobic(    ) 

 Hydrophilic/Hydrophobic/Surface   Set colors by Hydrophilic （   ）

/Hydrophobic(   )/Surface(   ). With the exception of the molecule surface, 

Hydrophilic/Hydrophobic are colored. 

 Function  Set colors by functions 

Function Color Peptide 

Acid  Asp,Glu 

Basic  Arg,Lys,His 

Neutral  Ser,Thr,Asn,Gln 

Aliphatic  Gly,Ala,,Val,Ile,,Leu,,Met 

Aromatic  Phe,Tyr,Trp 

Thiol-containing  Cys 

Imono  Pro 

 Select Residue Set colors by selected residues, and other residues are white. 

 Charged Residue Set colors by the value of charged residues.  

(＋:     ０ :      －:     )         

 Charge  Set colors by the value of charged molecules.If Check point file is 

ersion.2 , you can choose value HF/MP2. The displayed color is changed from red 

to white to blue, according to the changing values of electric charges.  When the 
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electric charge is not specified, set colors by atoms. 

 Atom      Displayed color by atom charge. 

 B Factor   Displayed color by temperature factor. Specify min/max value. 

 

Fig2.37 B Factor Dialog Box 

 Fragment  Displayed color by fragment charge. 

 Residue    Displayed color by residue charge. 

 

 

Fig2.38 Charge Dialog Box 

 Fragment Set colors by fragments from the eight colors cyclically as follows.    

 

 Chain Set colors to each chain from the eight colors cyclically as follows.  

 

 File Set colors to each file from the eight colors cyclically as well.  

 

 Structure Displayed color by 2nd Structure(αHelix,βsheet,others).  

 

2.2.5. Selection 

 

Fig2.39 Selection menu 
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Click on the display to choose atoms or residues as subjects.  

 Atom    Choose atoms as subjects.  

 Residue  Choose residues as subjects. 

 Fragment  Choose fragments as subjects. 

 

2.2.6. Tool  

 

Fig2.40 Tool menu 

 Display Atom in Distance   You can display atoms within the distance from 

selected a atom or a residue.  Before this menu is selected, click on atoms as 

subjects and specify the distance in the dialog box (Fig2.41). In the From 

selected option, choose between Atom and Residue.  In the Display List option, 

specify the display list of atoms, On or Off.  An example of the display list is 

shown in Fig2.42.  The contents of the atom list can be saved in text format 

from the [File] – [Save].  In the Distance option, specify the distance. 
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Fig2.41 Display Atoms in Distance dialog box. 

 

Fig2.42 Atom Lists on Distance Display  

 Display Residue in Distance   Display residues within the distance from 

selected a atoms, a residue or a fragment.  The residue can be displayed when 

any of the comprising atoms is within the distance. Before this menu is selected, 

click on atoms as subjects and specify the distance in the dialog box (Fig2.43). In 

the From selected option, choose Atom, Residue or Fragmnet.  In the Display 

List option, specify the display list of atoms, On or Off.  The contents of the 

atom list can be saved in text format from the [File] – [Save].  In the Distance 

option, specify the distance.   

 

Fig2.43 Display Residues in Distance Dialog Box 
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 Display Fragment in Distance   Display fragments within the distance from 

selected a atoms, a residue or a fragment.  The residue can be displayed when 

any of the comprising atoms is within the distance. Before this menu is selected, 

click on atoms as subjects and specify the distance in the dialog box (Fig2.44 

Display Fragment in Distance Dialog Box). In the From selected option, choose 

Atom, Residue or Fragmnet.  In the Display List option, specify the display list 

of atoms, On or Off.  The contents of the atom list can be saved in text format 

from the [File] – [Save].  In the Distance option, specify the distance.Specify 

the display label for the whole residues,fragment and atoms.  

 

Fig2.44 Display Fragment in Distance Dialog Box  

 Label   Specify the display label for the whole residues,fragment and atoms. 

This dialog box is shown in Fig2.45.  

 

Fig2.45 Display Label Dialog Box 

 Display H Bonds [all]   Display all Hydrogen bonds. When they are selected 

over again, they are deleted.  

 Display H Bonds [intermolecular]   Display Hydrogen bonds between 

molecules. When they are selected over again, they are deleted.  

 Display Dipole moment HF  The value of Dipole moment of HF of each 
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fragmentation is displayed by the arrow. The display option can specified The 

Preference dialog(Section 2.2.9). The display disappears when selecting it again. 

 Display Dipole moment MP2  The value of Dipole moment of MP2 of each 

fragmentation is displayed by the arrow. The display option can specified The 

Preference dialog(Section 2.2.9). The display disappears when selecting it again. 

 Multi Layer  It is available for CPF version 3 or more. Display style : High 

Layer:Stick. Middle Layer:Wire frame, Low Layer: Cα Line.  

 Reset Model & Color   Reset the display model and colors to the initial 

condition. Clear the assignment of each residue and atom. 

 Display Selected Residue     Display a dialog box to select residues which you 

want to display.  This dialog box is shown in Fig2.46.   When you click on the 

Select All button, all the residues are selected.  When you click on the Unselect 

All button, all the residues are unchecked.  

 

Fig2.46 Display Residue Dialog Box 

 Add Hydrogen  You can add Hydrogen to molecules in the PDB format.  Set 

Options, Input File and Output File in the dialog box (Fig2.47)   The PDB file 

name is set in the Input File and the other PDB file name added _addH is set in 

the Input File as the initial display.  After the execution, a dialog box is 

displayed, that ask if you want to switch the displayed file to the result file. 

Here, clicking on the Ok button lets the display switch. Refer to Section 7.5to set 

Reduce, Section 7.6 to set babel, Section 7.7 to set bond Builder. 
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Fig2.47 Adding Hydrogen Dialog Box 

 

Fig2.48 Confirm to replace Dialog Box 

 Hydrogen Capping Mode 

Specify hydrogen capping mode.  

Terminal: specify N,C edge process.  

Histidine : select hydrogen type at HIS. 

 

Fig2.49 Hydrogen Capping Mode Dialog Box  

 Optimize Structure 

Hydrogen Option file : Specify option file for add hydrogen. 

Optimize Option file : Specify option file for optimize. Option detail are 
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described at Section 5.  

Input File : Specify the input file. 

 

Fig2.50 Optimize Structure Dialog Box 

 TINKER 

Exectute Tinker program and display result. 

Program : Select a program. If you select Other, please input program name at 

text field. 

Options : Specify options for selected program. 

Input File : Specify the input file.  

Key File : Specify the key file. 

After the execution, a dialog box is displayed, that ask if you want to switch the 

displayed file to the result file. Here, clicking on the Ok button lets the display 

switch. The Result file name is ABC_program name.pdb if input file name is 

ABC.pdb. 

 

Fig2.51 Tinker Dialog Box 

 Overlay Molecule This option allows you to overlay molecules. Fig2.52 shows a 

dialog box for overlaying molecules.  
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Fig2.52 Overlaying Molecules Dialog Box 

Specify Type, Method, and Fit Number (Residue or Atom). 

1) Type 

Select a type as a subject to overlay from File, Residue and Atom. 

2) Method 

Select a method from C, Heavy Atoms and All Atoms.  By selecting this menu 

in the case of File or Residue in the Type, specify the atoms as subjects. 

3) Fit Number (Residue or Atom) 

You can specify files as subjects and set the numbers of atoms or residues of the 

files. The numbers can be selected by clicking on the residues and the atoms as 

subjects from a molecule structure display or Tree figure.  You can also type to 

input them.  If a number is a serial number, connect the serial numbers with a 

hyphen, “- “.  If it isn’t, type them separated by commas, “ , “. 

  Example 1  In the case of residues from 1 to 5, type” 1-5 “ 

  Example 2  In the case of residues, 1,2,5, type “1,2,5”. 

As the number which you select once can be deleted, use Back Space or Delete in 

order to cancel it. 

 If the number of atoms that you type is higher or lower, the lower number is 

selected.  By clicking on the Ok button, an overlaid branch structure is displayed.  

Here, the center of the movement each atomic group is that of the gravity of all 

the atoms which are used to overlay.  RMSD of the selected atoms is shown a 

message area 

4) Sort 

Specify sort for typed in atom numbers. 

 Complement Main Chain  

Complement main chain. Specify main chain No. that is complemented at Start 
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Residue NO. If you do not specify main chain No., viewer complement 

automatically for lock main chain. You can select residue No. by clicking residue 

object on Tree. Complement PDB File is used to complement. The result file are 

stored at start folder as xxx_complement.pdb (xxx is original file name)  

 

Fig2.53 Complement main chain Dialog Box 

 CHPI Execute CHPI program. Please refer section . 

 Set Rotation Center    This allows you to set a rotation center for mouse 

operation. The display can be rotated around an axis of selected atoms. 

 Reset Center    Reset rotation center for mouse operation. 

 Set File Rotation Center Set the center of gravity in each file for keyboard 

operation.  

 Add Text Display 3D text on 3D window. The Dialog is shown in Fig2.54. Load 

and save file which specified parameter at File menu. 

 

Fig2.54 3D Text dialog 
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 Text Specify text. 

 Font  Specify font.  

 Style  Specify Plane, Bold, Italic, Bold Italic 

 Color  Specify color. 

 Position(%) Specify position. After display text you can adjust the poison by 

mouse. Although the position of a mouse is at the lower left of a text, it may 

shift a little. 

 Add Display text. Added to the list under a button. Modification and 

deletion is possible by choose list. 

 Modify Modify display property. Click to the text list, display property of 

this text.  

 Delete Delete text. 
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2.2.7. Monitor 

 

Fig2.55 Monitor menu 

 Distance   Display a distance between atoms. After selecting a menu, clicking 

on two atoms lets the distance display.   In this mode, a color of the menu is 

green. By clicking on the same atoms, they disappear on the screen.  

 Angle   Display angles between atoms. After selecting a menu, clicking on 

three atoms lets the angles display.  In this mode, a color of the menu is green.  

By clicking on the same atoms, they disappear on the screen.  

 Dihedral Angle   Display a dihedral angle among atoms.  After selecting a 

menu, clicking on four atoms lets the dihedral angle display. In this mode, a 

color of the menu is green.  By clicking on the same atoms, they disappear on 

the screen.  

 Interaction Energy   Display the values of the interaction energy between  

selected fragments.  After selecting a menu, clicking on two atoms lets the 

value of the interaction energy between the fragments display. In this mode, a 

color of the menu is green. 

 Reset  This option allows you to reset an specified monitor. 

 VISCANA Amari et al. have proposed the visualized cluster analysis of 

protein-ligand interaction (VISCANA) for virtual ligand screening based on the 

FMO method, by using the dissimilarity between the interaction energy 
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patterns of two ligands and by representing each data point with a color that 

quantitatively and qualitatively reflects the interaction energy. Details are 

described in Section2.5 . 

 IFIE MAP 

Two-dimensional visual representation of IEIE matrix . Details are described in 

Section 2.6 . 

 FILM Isosurface Ishikawa et al. have developed a method named ”fragment 

interaction analysis based on local MP2 (FILM)” by combining the FMO method 

and local MP2 (LMP2). This function display isosurface by result of FILE. 

Details are described in Section2.7 . 

 Charge List(HF,MP2,HF NBO,MP2 NBO,HF ESP, MP2 ESP) 

Display charge value of HF,MP2,HF NBO,MP2 NBO,HF ESP, MP2 ESP. 

It’s also possible to output a list from File menu to a text file. 

MP2 is available after CPF Version 2, NBO is available after CPF Version 3. 

 

 Atom Display charge list of atoms. 

 Fragment Display charge list of fragments. 

 Residue Display charge list of residues.  

 Residue (DNA) Display charge list of residues. The sum total of the portion 

with the as other portion of DNA as a base is displayed.  

Example is shown in Fig2.56. It is also possible to output the list to the file. 
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(1) Atom    (2) Fragment 

     

(3) Residue   (4) Residue(DNA) 

Fig2.56 Example of charge list. 

 Sum of Charge  The total of the charge of the fragments, residues and 

atoms within the specified range are displayed. Fig2.57 shows the range 

specify window. 
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Fig2.57 The range specify window. 

 

 Interfragment Interaction 

 1:1  

You can set colors by the value of the interaction energy between 

fragments.  Select a reference fragment before selecting this menu.  Set 

colors by the energy value from the reference fragment.  Selecting this 

menu lets a dialog (Fig2.58) display to specify the value type, the range of 

values and the threshold values to set colors. The selection item of Value 

changes by Version of CPF. Please refer to section 2.6 for details. This is 

shown by kcal/ mol. Minimum and maximum values of whole files mean 

the defaults.  

  Many Body Calculation (Value:main+side chain) 

This option is available after CPF Version3. If checked it and the fragment  

is divided by fragmentation with a main chain and an another side chain, 

the IFIE value is colored one residue from the value which add value of 

main and side one. 

  Color 

Once you modify them, the interaction energy added colors within the 

range remains displayed until you select this menu next time.  When the 

minimum and the maximum are modified, put 0 to each value in order to 

set back to the default values.  When the threshold value is specified, the 

fragment under the threshold value of an absolute value can not be 

displayed.  This makes it possible to constrain the display on small 

fragments of the interaction.  

     In the case of the selection of this menu, when you click on molecular 
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structures, they are added colors by fragments you click.  

     When the fragments are not selected before opening this menu, 

molecular structures are added colors by fragments you select next.   

 

Fig2.58 1:1 Interaction Energy between Fragments Dialog Box 

 1:1 [lock]  

Set colors by the value of interaction energy between fragments.  Unlike 

the description above, when molecular structures are clicked, the reference 

fragment is not modified, and the atom’s information which you click on is 

displayed in the message area. Use this in order to get the atom’s 

information which you want to focus attention on, leaving the display on the 

screen.  In the case of this mode, residues and atoms can not be selected 

and the display attribute can not be modified.  

 N:1  

Select reference fragments before selecting this menu.  Set colors by the 

energy value from the reference fragments.  Selecting this menu lets a 

dialog (Fig2.59) display to specify the base fragments, the range of values 

and the threshold values to set colors. User can select multi-fragments on 

3D window by pushing the shift key, and also select them on the 

hierarchical window and the keyboard input.  
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Fig2.59 N:1 Interaction Energy between Fragments Dialog Box 

 N:N  

By selecting reference fragments and object fragments, calculate the  

interfragment interaction energy between both fragments. Display the 

value on the message area. A dialog box for N:N interfragment interaction 

is shown Fig2.60. Before selecting fragments , mark the check box on the 

left side of input field. 

 

 

Fig2.60 N:N Interaction Energy between Fragments Dialog Box 
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 List   

List the values of the interaction energy between a selected fragment and 

each fragment.  This list can be saved in the file.  Select [File]-[Save] 

under the menu bar and specify a file name so as to save the file. If the 

fragment is a side chain, “_s” is added to the residue name. An example of 

the display is shown in Fig2.61. 

If PIEDA selected, total, ES, EX, CT+mix, DI, Solvent are displayed. 

  

Fig2.61 List of Interaction Energy between Fragments 

 3 Body List Display value of 3 body and fragment#. If you click a list, 

correspond fragment is highlighted. Display options are energy lebel, 

maximum value and minimum. An example is shown in Fig2.62. 

 

Fig2.62 Example of 3 body value list. 
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 4 Body List  Display value of 4 body and fragment#. If you click a list, 

correspond fragment is highlighted. Display options are energy lebel, 

maximum value and minimum. An example is shown in Fig2.63. 

 

Fig2.63 Example of 4 body value list. 

 

This is example of Fragment Value:main+side chain parameter. The molecule is 

Tripcage. This fragments generated separately main chain and side chain. In Fig2.64 

SER20 is colored by each value, then In Fig2.65 colored by a residue.  
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Fig2.64 Example IFIE : Colored by fragment 

 

 

Fig2.65 Example IFIE : Colored by residue 
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2.2.8. Edit 

 Cut (selected)     This option allows you to cut the selected objects. 

 Cut(unselected)   This option allows you to cut the unselected objects. 

 Undo             This option allows you to undo and cut the objects. 

 Redo             This option allows you to redo the previous action. 

 

 

Fig2.66 Edit menu 

2.2.9. Preferences 

 

Fig2.67 Preference menu 

 Set Preferences  Popup a preference dialog box, which is shown in Fig2.68.  A 

specification item is changed with a tab. The value on the right side of the input 

field shows the suggested range.  If you increase the resolution to make the 

nice visualization, but you’ll need lots of time and a large memory to display.  

When done, click on the Apply button.  

 

Fig2.68 Preference Dialog Box 



50 

1) File 

This option allows you to load and save files by selecting [Open]-[Save] under 

the file menu.  When you execute BioStationViewer, load the file 

named .bioViewer from the current directory to the home directory in order.   

If there is a file, the setting is reflected.   

 The value of a default is set with Set Default Value.    

2) Rotation 

① Speed   Specify the rotation speed when Rotation in the ＶｉｅｗＰｏｉｎｔ is 

selected.   

3) Projection 

Specify Perspective or Parallel for the projection. If user choose Parallel, user 

do not magnify/shrink on mouse operation. User do magnify/shrink on 

Rotation/Translation/Magnify at the Viewpoint menu  

4) Connect Aom 

Select judgment standard for connecting bond from Van der Waals or covalent. 

Scale factor effect on judgment standard. 

5) Resolution 

① Line Width  : Specify a line width of a wire frame model.  

② C Line With  :  Specify a line width of a C[Line] model. 

③ Ball  :   Specify a resolution of a ball and stick model.  

④ Stick  :  Specify a resolution of a stick model. 

⑤ CPK  :   Specify a resolution of a space –filling model.  

⑥ Tube  :   Specify a resolution of a C[tube] model.  

⑦ Ribbon Width ：  Specify a width of Ribbon. 

⑧ Ribbon Height ： Specify a height of Ribbon(Solid) 

⑨ Ribbon Line Width ：Specify a width of line Ribbon(Line) 

⑩ Cartoon α Head Height ：Specify a height of cone of Cartoon(α Helix) 

⑪ Cartoon α Radius ： Specify a radius of Cartoon(α Helix) 

⑫ Cartoon width ： Specify a width of Cartoon(other) 

⑬ Cartoon β Height ：Specify a height of Cartoon(β sheet) 

 

6) Radius 

① Ball :  Specify a size of a ball in the ball and stick model. 

② Bond : Specify a line width of a bond in the ball and stick model. 

③ Stick:  Specify a line width in the stick model.  

④ Tube :  Specify a line width of Tube in the C[tube] model.   
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7) Color 

① Background  :  Select background colors in the display. 

② Atom  :   Set colors to each atoms.  This dialog box is shown in 

Fig2.69. 

 

Fig2.69 Atom Colors Preference 

③ Residue  :  Set displayed colors to each residue.  This dialog box is 

shown in Fig2.70.  

 

Fig2.70 Display Colors of Residues Preference 
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④ Fragment  :  Select displayed colors of fragments.  This dialog box is 

shown in Fig2.71.  Set colors to fragments, chains and files from the 

eight colors cyclically.  

 

Fig2.71 Display Colors of Fragments Preference 

⑤ Chain  :  Set displayed colors of chains. 

⑥ File  :  Set displayed colors of files. 

⑦ DNA :  Set displayed colors of ATGC of DNA.  

 

Fig2.72 Display Colors of the DNA  

⑧ Isosurface  :  Set colors of the isosurface value.  This dialog box is 

shown in Fig2.72. 

 

Fig2.73 Display Colors of the Isosurface Value 
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⑨ 2nd Structure : Second Structure. 

 

Fig2.74 Display Colors of the 2nd Structure 

⑩ Selected : Set color of selected item. 

⑪ IFIE : IFIE value 

 

Fig2.75 Display Colors of the IFIE Value 

8) Arrow：Specify the vector property. The dialog box is shown in Fig2.76.  

Arrow(Trajectory) : Specify arrow preference for trajectory. 

Arrow(Dipole moment HF) : Specify arrow preference for Dipole moment(HF)  

Arrow(Dipole moment MP2) : Specify arrow preference for Dipole 

moment(MP2) 

① Display The On/Off of a display of an arrow is specified. 

② Style Specify style of arrow. 

1. Radius  Specify the body and head width. 

2. Head Length  Specify the head length fix or ratio. 

3. Scale  Specify scale of arrow. The length of 1 of a display is 1Å. 

③ Color  Specify color. 

1. Value  Specify min,max value. The display color is changed from 

blue to read. 

2. One color Display the color which is specified 
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Fig2.76 Arrow Dialog Box  

 

9) Number of decimal 

Number of decimal for angle, distance, and IFIE value on 3D.   

 

Fig2.77 Number of decimal Dialog Box 

10) CHPI 

Specify CHPI result preference. The dialog box is shown in Fig2.78. 

① Model Select Model (Line Solid/Line Dash/Stick) 

② Color Specify color. 

③ Line Width  Specify line width 

④ Stick Radius  Specify Stick radius 

 

Fig2.78 CHPI Dialog Box 
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11) Multi Layer 

Specify the color of each layer. The dialog box is shown in Fig2.79. 

① High Layer Color  Specify the color of High Layer 

② Middle Layer Color Specify the color of Middle Layer 

 

Fig2.79 Multi Layer Dialog Box 

 

12) Font size 

 

Fig2.80 Font size Dialog Box 

 

 Display Axis Specify the presence of a coordinate axis in the lower-left side of 

the screen.   

 Display Direction Specify the presence of the direction to each file by typing.  

 

2.2.10. Help 

 View Help(Japanese/English)     Open a Pdf file to display a manual. 
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2.3. Section 

Section specification is performed on GUI by the specification of the central point, the 

specification of a rotation angle, or the normal vector of a section plane. Fringe and 

isoline are available. It is colored with the value of the file to input. The color scale 

range can be manually set to a specific minimum and maximum value. Multi-section is 

available. The diagram of section is shown in Fig2.81, and The Section dialog is shown 

in Fig2.82. 

 No. 

The number of the specified section is shown. By clicking Add button, add section.  

The specified section display as white transparency plane in 3d window. By 

clicking Delete button, delete the section.  

 Specify Section Plane  

 Center 

Specify the center points(X,Y,Z) of section by using the slider or the keyboard 

input.  

 Angle  

Specify the angle of section by using the slider or 

the normal vector of section. A purple axis is the  

center of an angle and an orange axis the is center 

of B angle. C rotates centering of the normal  

vector of section. 

 When specifying the normal vector(x,y,z), 

move the section by hitting Return key. 

 Set Plane 

Select a standard plane(xy, yz or xz). 

Fig2.81 The diagram of section 

 Section Property  

 Display  

Specify enable/disable to display the section. 

 Value  

Select value from the electrostatic potential or the electron density. 

 Color Range 

Specify the color range of value. 

 Type 

Select type from fringe or isoline. 

A 

C 

(X,Y,Z) 

[x, y, z] 

B 
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 Transparency 

Specify transparency. 

 Number of Lines 

Specify the number of Lines . In the case of molecular orbital 1e-8 is zero value.  

 Draw 

Draw the section. 

 

 

Fig2.82 The Section Dialog box 
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2.4. Trajectory 

2.4.1. File format 

The file format are two types. 

1) A file extension is trj. The file includes the value of the energy of each step. Type the 

number of atoms at the first line, an energy value at the next line and the coordinate 

of atom. Without energy value, type 0 at the energy line. # is a comment until the 

end of the line.  

Add Fragment No. at end of line for recognition of fragment. There may not be the 

description by you if there is no necessity of the fragmentation. Before load file  

select Color -> Fragment, molecular structure is colored by fragment number. 

 

Example of file. 

1000      # number of atom 

# step 0 

9.87654 # energy 

O 1.23345678 1.23345678 1.23345678 

H 1.23345678 1.23345678 1.23345678 

N 1.23345678 1.23345678 1.23345678 

C 1.23345678 1.23345678 1.23345678 

..... 

# step 1 

9.87654 # energy 

O 1.23345678 1.23345678 1.23345678 

H 1.23345678 1.23345678 1.23345678 

N 1.23345678 1.23345678 1.23345678 

C 1.23345678 1.23345678 1.23345678 

..... 

 

Example of file with fragment number 

1000      # number of atom 

# step 0 

9.87654 # energy 

O 1.23345678 1.23345678 1.23345678 1 

H 1.23345678 1.23345678 1.23345678 1 

N 1.23345678 1.23345678 1.23345678 1 

C 1.23345678 1.23345678 1.23345678 2 

..... 

# step 1 

9.87654 # energy 

O 1.23345678 1.23345678 1.23345678 1 

H 1.23345678 1.23345678 1.23345678 1 

N 1.23345678 1.23345678 1.23345678 2 

C 1.23345678 1.23345678 1.23345678 2 

..... 
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2) New trajectory file format. File extensions are trj2, tj2,tr2. It is extensional format 

of XYZ. The number of atoms, a comment, atomic coordinates, and the vector 

value are described for every step. A comment is expressed in the group of a tag 

and a value and displays graph with this value. When a tag is “Label”, it becomes 

the text of 3d viewer. "=" is described between a tag and a value. There may be "," 

between items. Refer to the Arrow of Preference specification for change of the 

display attribute of a vector. 

 

Example of file. 

8 

label="MD step 1" Ekin(Ha)=0.0000000000 Epot(Ha)=-31.6395526318 

Etot(Ha)=-31.6395526318 Fmax(Ha/bohr)=0.1505408174 

Si 0.8686973703168 0.5700826492704 0.67866982056 -0.090561 0.076468 -0.082145 

Si 4.6421015726304 4.7235419510976 4.75068874392 0.026857 0.018088 0.002683 

Si 0.67866982056 3.4204958956224 3.5019362740896 -0.022970 0.000783 -0.024173 

Si 4.75068874392 2.03600946168 2.03600946168 0.032733 -0.001620 -0.002599 

Si 3.4204958956224 0.7872569918496 3.3933491028 -0.012222 -0.029104 -0.017059 

Si 1.764541533456 4.886422708032 2.03600946168 0.101043 -0.077951 0.079853 

Si 3.5019362740896 3.3933491028 0.7058166133824 -0.050445 -0.000565 0.003814 

Si 2.03600946168 2.0088626688576 4.6421015726304 0.015567 0.013899 0.039625 

8 

label="MD step 2" Ekin(Ha)=0.0000001274 Epot(Ha)=-31.6395536508 

Etot(Ha)=-31.6395535234 Fmax(Ha/bohr)=0.1505348131 

Si 0.868696441081553 0.570083434040259 0.678668977580644 -0.090558 0.076465 -0.082141 

Si 4.64210184833175 4.72354213683881 4.75068877143722 0.026857 0.018087 0.002683 

Si 0.678669585076125 3.42049590356006 3.50193602590547 -0.022970 0.000783 -0.024173 

Si 4.75068907994755 2.0360094452755 2.03600943522114 0.032732 -0.001620 -0.002599 

Si 3.42049577020739 0.787256693393632 3.39334892764233 -0.012222 -0.029103 -0.017058 

Si 1.76454257011423 4.88642190844518 2.03601028084638 0.101040 -0.077948 0.079849 

Si 3.50193575655425 3.39334909697905 0.705816652541516 -0.050443 -0.000565 0.003814 

Si 2.03600962149153 2.00886281120628 4.64210197903853 0.015567 0.013899 0.039623 

….. 

 

2.4.2. Control animation 

Load a trajectory file from File menu at the main window. Display processing is 

performed at the time of file reading. In proportion to the number of steps, the number 

of atoms, and the display style of molecular structures, it takes processing time. After 

processing pop up a trajectory control dialog box(). If the file includes energy, an energy 

graph appears on the panel. 
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Fig2.83 Trajectory Control Dialog box 

1) menu 

 File 

 Create image files 

Output a JPEG file to create an animation file at the specified directory. The 

file name is imageXXX.jpg. Sequential numbers go into XXX. Specify Output 

Folder and Screen Size, and by clicking Create button, display each step and 

output files. However, keep in mind that it may drop out some frames with the 

performance of CPU and a graphic card. 
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Fig2.84 Create Image Dialog box 

 

 Create Video File 

Create video file as output file name. You can choose two Video Format, 

MSVIDEO and Quick Time. MSVIDEO needs a large disk but easy to use with 

Power Point. Quick Time file is small file size and needs Quick Time player to 

play video.  

 

Fig2.85 Create Video Dialog box 

 

 Save Graph Image File 

The graph currently displayed can be saved as JPEG, PNG, or a Postscript file. 

Form is judged by the extension of the file name specified on the file selection 

dialog. 

 Close 

Close this dialog. 
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 Mode 

 Cyclic 

Play cyclic. 

 

 Text 

Specify 3D text property. Font, Style, Size, Color and Position. The dialog box is 

shown in Fig2.86. 

 

Fig2.86 Text Dialog box 

 Width 

 Ajust 

The size of a graph horizontal axis is united with the size of a display window, 

and the whole is displayed.  

 

2) Control Panel 

  top 

skip to the top frame. 

  reverse 

reverse play 

  back 

back 1 frame 

  stop 

stop 

  tail 

skip to the last frame 
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  play 

play 

  forward 

forward 1 step 

 Interval Time [sec] 

Interval Time. Too small value is not available. 

 Current Step No. 

Display a current step number. If user input a step number and hit Return key, 

display that frame. The step number starts from 0.  
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2.5. VISCANA 

The visualized cluster analysis of protein-ligand interaction (VISCANA) for virtual 

ligand screening based on the FMO method, by using the dissimilarity between the 

interaction energy patterns of two ligands and by representing each data point with a 

color that quantitatively and qualitatively reflects the interaction energy.  

When you select [Monitor]-[VISCANA], popup an window of VISCANA(Fig2.87). 

Main View consists three parts. At the left side, show the dendrogram that described 

result of cluster analysis. At the middle part, show the ligand name and add color by 

binding energy. When you take the mouse cursor on the item, show the binding energy 

of this ligand. At the right side, show interaction energy between ligand and each 

fragment of protein.  

When you take the mouse cursor on the item, show the interaction energy and 

fragment number. It is working with 3D View. Select a fragment by push left button of 

mouse cursor on the fragment, and clicked “3D Model View” button, display molecular 

structure on 3D View with highlighted that fragment. It is easily understood where 

there is a position of the fragment that you are selected.(Fig2.88) 

There are two tabs ”Data” and ”Analysis” the lower part of window. Specify display 

properties at “Data” tab, display result of Cluster Analysis at “Analysis” tab.  

 

Fig2.87  VISCANA window 
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Select 2GIUcell, and click “3D Model View” button 

 

Fig2.88  High light No.40 fragmnet. 

 

2.5.1. Menu 

 File menu 

 Load CSV File 

Load CSV file and visualized. File format : 1 line shows 1 file.  

  file name, value#1, value#2 …. value#N  

It continues number of files.  

 Save image 

Save image file(PNG/Tiff) 

 Save CSV file(Raw data) 



66 

output IFIE raw data as CSV. 

"1ERE H2O EST600","0.06704805904155364","0.004935882592690177","-0.004161305550951511","-0.003949102 

"1L2J ETC600","0.09012984097353183","-0.01233636905089952","-0.06828176585258916","-0.01509068469749 

"2I0G I0G1","0.017258612366276793","-0.001573896166519262","0.018046159180812538","0.007235390599817 

"1QKM GEN600","0.06880561851721723","-0.021663096427801065","0.014909053323208354","0.00948922598036 

"1U3Q 272501","0.03297848604415776","-0.022831991052953526","-0.029928279720479622","-0.030791792451 

Fig2.89  Example file of Save CSV file(Raw data). 

 Save CSV file (Raw data with cluster#) 

output IFIE raw data with cluster# as CSV. 

"Cluster","Title","GLU266(1)","GLN267(2)","LEU268(3)","VAL269(4)","LEU270(5)","THR271 … 

"1","1L2J","0.004422543410328217","-0.0017177658883156255","-0.00244106788886711","-0 … 

"1","2JJ3","-0.0029467978893080726","0.009508218805422075","0.00513503716501873","0.0 … 

"1","3OLS","-0.02434854664898012","0.016759303412982263","1.7115636728703976E-4","0.0 … 

"1","4ZI1","-0.010549071987043135","0.008117687830235809","-0.0062418528978014365","0 … 

"1","1YY4","-0.01569034659769386","-0.0017285672220168635","-0.01229054767463822","-0 … 

"1","2YJD","0.0018548246443970129","-0.016161552906851284","-0.01687829554430209","-0 … 

"2","1QKM","-0.01033311647188384","0.016623245552182198","-0.009609946864657104","-0.  … 

"2","1U3S","-0.029734298965195194","-0.002225780044682324","-0.018211634043836966","- … 

"2","1YYE","-0.03943274790071882","-0.0013379475567489862","-0.021705138933612034","- … 

"2","1U3Q","-0.03647428649128415","0.0033225355291506276","-0.02517848760180641","-0.  … 

"2","1U9E","-0.01673011857928941","-0.0054608482751064","-0.010434834490297362","-0.0 … 

"2","1X76","-0.0112376005272381","-0.0026311323599657044","-0.021413976384792477","-0 … 

"2","1X78","0.007286158637725748","0.010399236518424004","-0.010982639651047066","-0.  … 

"2","1X7B","-0.028911706773214974","0.002566304348874837","-0.011377972521586344","7.  … 

"3","1U3R","-0.029407480076770298","0.007906074039055966","-0.0059105008986080065","0 … 

"3","1ZAF","-0.027610782271949574","0.009124418895225972","2.941601269412786E-4","0.0 … 

"3","2QTU","0.023051065276376903","0.011827122478280216","-0.0036844993592239916","-0 … 

"3","2NV7","-0.04559103159408551","0.010739662931882776","-0.0036646668886533007","0.  … 

"4","2Z4B","0.023356488600256853","0.008737203490454704","-0.0036989772343076766","-0 … 

"5","2GIU","0.04086011557956226","-0.008129799374728464","-0.018197902871179394","-0.  … 

"5","3OMO","0.00813774490961805","-0.010438287048600614","-0.01630014342663344","-0.0 … 

"5","3OMQ","-0.01761319577053655","-0.013049710614723153","-0.021847352050826885","-0 … 

"5","3OMP","0.05095229222206399","-0.0370117163984105","-0.022769159768358804","-0.03 … 

Fig2.90 Example file of Save CSV file(Raw data with cluster#). 

 Save CSV file (filtered data) 

Output IFIE data from Base Fragment in specified distance. Specify output file 

name(ex. IFIE_filtered.csv), then output index information file(ex. 

IFIE_filtered_fragment_number.csv) . Example shows in Fig2.91. 

 

"1ERE H2O EST600","0.06704805904155364","0.004935882592690177","-0.004161305550951511","-0.003949102 

"1L2J ETC600","0.09012984097353183","-0.01233636905089952","-0.06828176585258916","-0.01509068469749 
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"2I0G I0G1","0.017258612366276793","-0.001573896166519262","0.018046159180812538","0.007235390599817 

"1QKM GEN600","0.06880561851721723","-0.021663096427801065","0.014909053323208354","0.00948922598036 

"1U3Q 272501","0.03297848604415776","-0.022831991052953526","-0.029928279720479622","-0.030791792451 

a) output file 

"1ERE H2O EST600","1;19;19","1;20;20","1;21;21","1;33;33","1;34;34","1;35;35","1;36;36","1;37;37","1 

"1L2J ETC600","2;19;17","2;20;18","2;21;19","2;33;30","2;34;31","2;35;32","2;36;33","2;37;34","2;38; 

2I0G I0G1","5;19;17","5;20;18","5;21;19","5;33;30","5;34;31","5;35;32","5;36;33","5;37;34","5;38;35" 

"1QKM GEN600","3;19;17","3;20;18","3;21;19","3;33;30","3;34;31","3;35;32","3;36;33","3;37;34","3;38; 

"1U3Q 272501","4;19;17","4;20;18","4;21;19","4;33;30","4;34;31","4;35;32","4;36;33","4;37;34","4;38; 

b) index information 

Fig2.91 Example file of Save CSV file(filtered data). 

 Close 

Close this window. 

 

2.5.2. Data tab 

1) CPF Data Directory 

Specify data directory that stored data files. The result files are check point files 

that applied to different ligands for the same protein and must be same fragment 

number. Click “Load” button then load files. After load files, “3D Model View”, “Apply” 

button and “Ligand Fragment No.” is available.  

  

2) Data Select 

Specify energy type for clustering. IFIE Energy or PIEDA value. 

  

Fig2.92  Data Select Panel. 

 

Fig2.93 Example of Legend. 



68 

 

3) Cluster Analysis 

 

Fig2.94 Cluster Analysis Panel. 

 Base Fragment 

It is base fragment number that for cluster analysis. 

 IFIE/PIEDA(X)  

Specify color and range of Interaction Energy. The default min/max value set 

from loaded file.  

 Sum over X 

Specify range of Binding Energy. The default min/max value set from loaded file. 

 Cluster Method 

Select method for cluster analysis. There are bellow methods. 

 furthest neighbor  

 nearest neighbor  

 group average  

 centroid  

 median  

 Ward  

 flexible  

 Apply 

Click “Apply” button, then redisplay by specified parameter. 

 

4) View Filter 

 Distance 

Specify distance from Base Fragment. 

 Distance Type 

Specify distance method. 

Neaest Interatomic : nearest distance between atoms. 

Center of mass :  distance from center of the fragment. 
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 Filter 

Click “Filter” button, then redisplay by specified parameter. 

 

Fig2.95 View Filer Panel. 

5) 3D Model View  

” 3D Model View” button function : At first visualized data and select a fragment on 

the right side, then click ” 3D Model View” button, display molecular structure on 3D 

View with highlighted fragment. Show the example (エラー! 参照元が見つかりません。) . 

 

2.5.3. Analysis tab 

Display yellow dash line on dendrogram at mouse position, when select “On” at 

“cluster No” parameter. Then display cluster# root of dendrogram. When you’d like to 

display the cluster # in the desired position, hold the mouse cursor in that position and 

it goes out of the top or the bottom of dendrogram.  

 

Fig2.96 Anaysis tab. 
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When a horizontal line of a dendrogram is clicked, the selected cluster number is shown 

as "*", and ligand name set on the text area at checked box #1 or #2. Color of ligand 

name #1 set mazenda and #2 set green. If you click other than a horizontal line, the 

selection will be canceled. 

 

 

Fig2.97 Select cluster. 

Click “Apply” button then calculate the difference of average in values. Display 

fragment number and value in order absolute value on the Result list panel.  If clicked 

list value, the applicable fragments are displayed in a yellow frame. 

 

Fig2.98 Example of cluster analysis. 
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2.6. IFIE MAP 

The IFIEs illustrate the information about the interaction energies between the 

fragments consisting of amino acids, nucleotides and other molecules. The whole IFIEs 

are represented as a matrix form called an IFIE matrix and visualized as MAP. The 

Map add color by IFIE value, and Second Structure is shown at upper and left part. By 

clicking on “＋” “－“ buttons, the graph is scalable. When you take the mouse cursor on 

the item, show the interaction energy and fragment number. By clicking the item, 

display highlighted that fragments on 3D View. 

Select File->Open File menu and load check point file. Select Monitor->IFIE MAP 

menu then IFIE window is displayed. Example is shown in Fig2.99 

 

Fig2.99  IFIE MAP Window 

1) Instruction of menu 

 File menu 

 Save image 

Save image file(PNG/Tiff/Jpeg). 

 Save text 
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Save text file(index, value). 

 Close 

Close this window. 

2) Visualize Parameters 

A specification item is changed with a tab. When "Apply" button is clicked after 

parameter specifies , the MAP is changed.  

 Display Value 

The color parameter panel is shown in Fig2.100. 

 

Fig2.100  IFIE MAP Display Value panel 
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 Format 

 

Fig2.101  Format panel 

 Separate(-/+) 

The negative values are displayed on left side and the positive values 

are displayed on right side. The example is shown in Fig2.99. 

 Symmetric 

The negative/positive values are displayed on both side. The example 

is shown in Fig2.102. 

 Distance Matrix 

The Symmetric is displayed on left side, the distance between 

fragments is displayed on right side. The atom that becomes base of 

distance is specified next panel. The example is shown in Fig2.103. 

 

Fig2.102 Example of Symmetric  
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Fig2.103  Example of Distance Matrix 

 

 Value 

Select the kind of energy. This menu item changes by the version of CPF. The 

each menu item is shown in Fig2.104. 

    

a) Version1            b) Version2 
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          c) Version3,4.-4.2, 7.0           d) Version 4,201, 7.0-4.0, Open1.0 rev10 

  

e) Open1.0 rev21 では、記述されていないエネルギーはグレーアウトされる 

Fig2.104  IFIE MAP Value panel each version 

In case of the result of super molecule, Super Molecule Step2 button is available, 

select this button and the step2 result is displayed as MAP. 

In case of the result of many body, Many Body Correction button is available, select 

this button and the many body correction value is displayed as MAP.  

 

If CPF version is 3, you can choose compound-IFIE. This dialog is shown in Fig2.105. 

Calculate value from some results. Specify coefficient and Value for each file. 
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Fig2.105  Compound IFIE Dialog box 

 

 Color 

 Auto 

Add color by range of value(min,max) each of Color(-) and Color(+). Log 

and linear can be specified for the type of scale. If 0 is specified as Ｌｏｇ 

value, it is changed to 1e-10. 

If you select ”Colored” as Outside the range, the beyond the limits of 

minimum/maxmum value is displayed by the color of the maximum 

value and minimum value. If you selects ”None”, do not add color. 

 Custom 

The value within specified range (min<max) is displayed by the specified 

color. It becomes white outside the range. When "Color" button is clicked 

popup the color dialog. The example is shown in Fig2.106. 
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Fig2.106 Example of custom color 

 

 Distance Matrix 

 Add color by range of value(min,max). Log and linear can be specified for 

the type of scale. If 0 is specified as Log value, it is changed to 1e-10. 

 Distance Matrix(Base atom) 

Specify the atom that becomes base of distance incase of peptide, DNA and 

others.  

1) Center of Mass 

2) The shortest interatomic 

3) custom 

Please specify atom type name in the check point file. In the case of 

DNA(1fragment is 1DNA) , select as the base atom either of backbone or base. In 

the case of others(fragments is not peptide and DNA), specify the base atom in 

text field. This format is “fragment No. : atom name”. If there are some 

parameters, input parameters that are separated by the space character. 

Example “222:C3’ 244:P” 
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Fig2.107  Distance Matrix 表示例 

 Fragment Order 

Specify the order of displaying the fragmentation on MAP.  

All: specify the order for all fragments.  

Chain : specify the order for each chain.  

If mark the check box , it is displayed. It is displayed in input order and the 

format is possible to specify it as follows. 

1) Start fragment No. ― End fragment No. ： increment 

Specify the start fragment No. , end fragment No. and increment. 

example 200-220:2 

2) Residue name 

It is specified three character such as GLY, ASP. 

(This format is only available in All) 

 Clear fragments 

Clear input parameters. 

 Set Default 

Set default values. 

 Add fragments in range 

It is a miscellaneous function to specify the fragmentation number at All 

and Chain. Click the fragment in 3D view, that fragment No. is displayed 

at No. field. Two or more fragments can be specified. Specify the distance 

from fragment at front of Å then by clicking the “Add” button, the 
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fragment No.s that in range are added at parameter fields.  

There are two methods in calculation of distance. “Center of mass” is 

center of mass of fragments, ”The shortest interatomic” is The shortest 

interatomic distance.  

 Sort by base/backbone(DNA) 

The displayed order sort by base/backbone. 

 Sort by Main/Side Chain 

In case of multi layer calculation, it will be displayed in the oerder of 

main/side chains. 

 

Fig2.108  IFIE MAP Fragment Order panel 

 Graph 

Display the graph that have a horizontal axis as fragment No. and a vertical axis 

as IFIE value. The fragments No. is specified for the field. If two or more 

fragments are specified display sum of these values. Label display at upper of 

graph.  The range of value is specified as a vertical axis. By Clicking the ”Draw 

Graph” button, display the graph. The example is shown in Fig2.110. 
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Fig2.109  IFIE MAP Graph panel 

 

Fig2.110  Example of graph 

When you take the mouse cursor on the graph, show the fragment No. and value.  

 

Show the File menu in bellow. 

 Load CSV file 

Load CSV file that saved by “Save CSV file”. 

 Save CSV file 
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Save the file that format is CSV. 

 Save Image 

Save the image file(png,jpg,tiff). 

 

3) instructions  

 Apply 

Display the MAP with parameters. 

 Reset 

Reset the MAP. 

 Enlargement, Shrink and Translate  

  

 Structure Note 

Display second structure or chain at upper/right of MAP. 

 Enlargement by mouse 

The rubber band is appear by push the left button on mouse. When release the 

button, enlarge display area.  

 Display value 

When you take the mouse cursor on the graph, show the fragment No. and value.  

 

 Highright fragment in 3D view 

By clicking the right button of mouse on item, display highlighted that 

fragments on 3D View. 
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2.7. FILM Isosurface 

Load FILM result file, specify the orbital and display isosurface. At first load the 

check point file then select Monitor→Film isosurface. Popup FILM window. 

 

Fig2.111  FILM Window 
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1) Menu 

 File menu 

 Close 

Close the window. 

2) Parameters 

 Data Directory 

Specify the folder that is stored result files. The convention of result filename is 

xxx_n_m.lmp2.（xxx:any、n.m fragment No.）。After specify the folder, load result 

files and display Fragment Pair. 

 Fragment Pair 

Display fragment pair. Select a fragment pair, display that orbital at Orbital. By 

clicking ”Highlight fragments in 3D graphics” button then display the 

highlighted fragment in 3D View. 

 Orbital 

Select item(Inter Fragment/Inner Fragment/All/None) of Sort by energy.  

Inter Fragment : list item are sorted by the energy between inter fragment. 

Inner Fragment : list item are sorted by the energy between inner fragment. 

All : list item are sorted by the energy of all pair. 

None : Select the each orbital. 

Display orbital number at Selected pairs and sum of energy between selected 

orbitals at Calculate Energy. Two or more orbitals can be specified. Selected 

orbitals is possible to edit. After edit this field, enter the return key then display 

that energy.  

Maximum number of pairs list : Specify maximum number of orbital pairs in 

list. It is available by pressing enter key. 

 

If from 3D marked, when click the atom in 3D view, display related orbitals at 

Selected pairs. 

 

Selected orbitals : The starting track number of the selected orbital is set. It’s 

editable, if you press the Return key, Sum of Energies will be calculated.  

Sum of Energies : Display value which the total sum of the combination of the 

selected orbitals. Integrated target is Inter,Inner or All which is selected option 

of Sort by energy.  



84 

 

Fig2.112 Example of Inter Fragment list 

 

Fig2.113 Example of None 

 

 Display Matrix 

Display energy matrix between orbitals on the other window. Display energy 

that included fragment by fragment order. The displayed color is changed from 

red to white. Change min/max value and by Clicking “Apply” button, redisplay 

matrix. When you take the mouse cursor on the matrix, show the orbital index 

and energy. By Clicking item on matrix, set orbital index at “Selected orbitals”. 

Click item with push control key, add orbital index. Ezample is showed in 

Fig2.126. 

There are three display types, ”Inner Frament”,”Inter Fragment” and ”All”.  

Save image file(PNG,Tiff,JPG) by selecting File→Save Image menu. 

 Isosurface Parameter 

The color of each fragment can be specified. phase 

If draw two or more orbitals that have different phase so upset isosurface color,   

the color in each orbital can be specified according to the following instructions. 

By clicking “Set” button, set parameters on selected orbital. Draw a isosurface, if 
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upset isosurface color, select Color(+,-)  button and click Set button. This 

setting of each orbital is done, all orbital draw at the same time. 

 Draw 

Draw isosurfaces that are selected. 

 Delete 

Delete isosurface. 

 

 

a) click at (25,48) 

  

b) selected orbital pair on the list  

Fig2.114  Example of Matrix 
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Fig2.115  Example of FILM isosurface 
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2.8. Editing ABINIT-MP Input File 

When you select [File]-[Edit ABINIT-MP Input File], popup an edit window of 

ABINIT-MP input file. This input file version is ABINIT-MP Open 1.0 rev.10. Input 

fields in Optimize and FMO Calculation are displayed by choosing On. 

CNTRL,FMOCNTRL,SCF and BASIS are mandatory parameters, Please set other 

items if necessary. Please refer “ABINIT-MP manual” about detail of parameters. This 

edit display is shown in the Fig2.116.   

This window consist tabs. Please input parameters that you need at each tab. Default 

file name is set to “Read Geometory File” at the Control tab, but you have to change the 

path for the calculate server when you execute by this file on it.  

Please refer to ABINIT-MP program manual for details of each item. I explain the 

File menu, Fragment editing function (FMOCNTRL) and Fragment Pair (FRAGPAIR).  

 

 

Fig2.116 ABINIT-MP Input file edit window 
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2.8.1. File Menu 

Show the File menu in bellow 

 

Fig 2.117 File menu at ABINIT-MP Input file edit window 

1) Open File  

Open input file. 

2) Save File  

Save input file 

3) Set Default Value 

Set Default Values 

4) Close 

Close this dialog. 

 

2.8.2. Edit fragment (FMOCNTRL) 

FMOCNTRL tab is for fragmentation parameters. Auto Fragmentation is division 

parameter of fragments, it has 3 mode(On/Off/Hybrid), explain them following.  

1) On : generate fragments by automatic method. Some parameter needs. 

2) Off : at first generate fragments by automatic method, then divide the fragments 

manually. All the information about fragments is described in AJF. 

3) Hybrid : at first generate fragments by automatic method, then divide the 

fragments manually. Only the modified information about fragments is described 

in AJF. It’s convenient if you check only the part of manually fragments. 

Selected ”On” is shown in Fig 2.118, selected “off” or ”hybrid” is shown in Fig 2.119. By 

Clicking “Set Fragmentation” button, then pop up the fragment edit window(Fig 2.120).  

 



89 

 

Fig 2.118 Auto Fragmentation is “On” 

 

Fig 2.119 Auto Fragmentation is Off or hybrid 

 

Fig 2.120 Fragment edit window 
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The edit window displays information of fragment at the upper part and consists of 

four tabs for editing at the bottom, explain them following. 

 

a) Fragment information 

The following information is shown as fragment information. 

・ Fragment number : It is button. By clicking it, high light atoms in 3D display. 

・ Formal charge : editable. 

・ Number of interfragment bond 

・ BDA connected atom 

・ The atom no. of fragment 

・ Molecular Weight 

 

“Display All Information”  Specify the way of display information  

  Yes ： Display all information. 

No : Display only edited fragments and specified fragmnets at HybridFrag. If you 

click “Apply” button after specified fragmnets at HybridFrag, it will change to 

the display of specified fragments only. The edited fragment displays “*” on 

the left. The number that specify as HyblidFrag is decided one when divided 

automatically. 

 “Fragment Position by sort”  Specify how to insert edited fragments in case of hybrid. 

Yes : The insertion location is determined by the atomic numbers other hydrogen 

contained in the fragment  

No : Add it at the end of automatically generated fragment. 

 

b) Edit fragments 

It has four tabs, Generate Fragments, Merge Fragment, Create New Fragment and 

Add/Delete Bond.  

By clicking the atom on 3D view or Tree view, then set the atom No. or fragment No. 

on input field. The atom# add the input field automatically so you have to clear before 

click the atom if you don’t add one. 

(1) Generate Fragments 

If you want to auto fragmentation for protein, select ”Auto” tab. If you want to 

manually fragmentation for protein/demdrimer, select ”Manual” tab. If you want to 

auto fragmentation for crystalline molecules, select ”Crystal” tab. 

1) Auto fragmentation for protein 

After specify the parameters, by clicking ”Generate Fragment” button, execute auto 
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fragmentation and display result on 3D view. By clicking ”View Log” button, display 

log file. If there is a charge at the connecting part between fragments, display the 

ellipse ball and small boll. The small boll is a bond detached atom. The Formal 

Charge and #Interfragment calculate automatically then set input field at 

Add/Delete Bond tab. 

Example is shown in Fig2.121. 

 

Parameters 

 

 

Fig2.121 Result of auto fragmentation for Gly5（add color by fragment） 

Number of Residue for each Fragment  Number of fragment per 1 residue. 

Polynucleotide  When a DNA is divided, this option specifies whether to divide 

nucleotide into small fragments. 

   +base : Do not divide a nucleotide into small fragments. 

   /base : Divide a nucleotide into base and backbone fragments. 

   /suger : Divide a nucleotide into base, sugar and phosphate group framents. 

Aminoacid  When a protein is divided, this option specifies whether to divide an 

amino acid into small fragments. 

   +amino: Do not divide an amino acid into small fragments. 

   /amino: Divide an amino acid into main chain and side chain fragment. 

Carbone hybrid orbital  How to divide carbon chain.  

    sp3: sp3 : divide at –C–C-connect 
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    sp2: sp2 : divide at –C=C-connect 

Rsolv This keyword specifies the distance threshold values used to determine if the 

ions are merged into the surrounding fragments. In the following example, the Ca 

and Zn ions are merged into their surrounding fragment, which exists within 2.8 

and 2.4 Angstrom from the ions, respectively. 

    Ex) Rsolv='Ca=2.8,Zn=2.4' 

Na, Mg, K, Ca, Mn, Fe, Co, Ni, Cu, Zn, Br atoms can be specified in the keyword. 

Ligand Charge  charge per fragment. 

 

2) Manual fragmentation 

Fragment at the same atom name of start atom while search for the direction is 

Start→Next. Click the start atom and next atom in 3D view, so the atom is set at 

input field of ”Start Atom”,”Next Atom”. ”BDA” specifies the direction for BDA. 

"Interval" specifies whether to set the fragment point at intervals when the same 

atom name as Start is found. If you have some fragment direction, click “Add” 

button and specify parameters. By clicking “Delete” button, delete current 

parameters. The example of parameters is shown in Fig2.122, the example of result 

is shown in Fig2.123. In case of  Si12H26, cannot check connect atoms by default 

preference. So Please parameter of Scale set 1.3 at Preferences→Set Preference→

Connect Atom. 

 

 

Fig2.122 Example of dendrimer parameters 

Ｓtart Atom(17) 

Next Atom(20) 
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Fig2.123 Result of auto fragmentation for Si12 

 

3) Auto fragmentation for Crystal 

Click button “Generate Fragment” to execute the automatic fragmentation after 

specifying the following parameters. 

Crystal（residue name） If the given system is composed of a crystal and other 

molecules, the residue name of the crystal need to be specified in the text input field. 

The residue name is used to separate the crystal. The residue name appears in the 

PDB file. 

Minimun atoms to marge  This specifies the number of atoms for minimum 

fragment. In the fragmentation specified the Detail Fragmentation (see below), the 

generated fragment, whose number of atoms is less than the number specified in 

this field, automatically merged into the surrounding fragment. 

 

Fig2.124 Example of parameter for crystal. 

Fig2.125 shows a screenshot during the automatic fragmentation for the complex of 

SiO2 cluster model and absorbed peptide.  
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Fig2.125 Specifying parameters on GUI and the result of automatic fragmentation for 

the complex of SiO2 and peptide. 

(2) Marge Fragment 

Marge two fragments or atoms for selected fragment. When the input field of Base 

Fragment is cleared, set the fragment# or atom# of the atom is clicked by 3D view or 

the Tree view. The number is set in the field that is selected by radio button.  

 

(3) New Fragment 

Create new fragment with the specified atoms. If you select “YES” at “Edit Bond”, 

move to Add/Delete Bond tab by clicking “Create New Fragment” button.  

Please set to YES, and specify BDA when connected fragmentation already made. In 

case that create new fragmentation of Ligand, set to No at “Edit Bond”, please set 

BDA after making all fragmentations.  
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(4) Add/Delete Bond 

Specify bond between fragments. If there is a BDA between fragments, click two 

atoms and click “Add” button then add a bond. The formal charge allocates from 

“Bond Detached Atom” to “Connected Atom” .  

By clicking BDA node in 3D view or select in list, and click “Delete” button then 

delete the bond. Please edit Formal Charge if it is necessary. 

 

 

Remark!! 

 If it have a connecting between fragments and not specify a bond, the error 

occurred when save a parameter file. The message dialog is shown in Fig2.126.  

 

Fig2.126 The error dialog about bond. 

 When close fragment window, disappear bond nodes in 3D view.  

 



96 

2.8.3. Fragment pair(FRAGPAIR) 

Specify Fragmentation Pair used to calculate BSSE. This panel is shown in Fig2.127. 

 

 

Fig2.127 Fragment Pair panel 

 

1) Add fragment # that picked in3D viewer 

Please select On when you display the fragmentation number to the text area with 

the cursor when the fragmentation is clicked by 3D viewer.  

2) Range 

The fragmentation pair in specified range.  

3) Group 

The Pair between fragmentations specified for Group1 and Group2. If you choose On 

at Enable Inner Fragment, generate pairs in same group fragmentation.  

4) Get Fragment Pair 

Display Fragmentation Pairs that was specified for the above.  

5) Fragment Pair List 

Display Fragmentation Pairs. You can edit it.  

6) Highlight Fragments in 3D Viewer 

The fragmentations in 3d viewer is shown highlighted.  
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2.9. Basic Action 

2.9.1. Enlargement, Shrink, Rotation and Translate 

A displayed figure can be enlarged, reduced, rotated and moved. Operations of each 

action are shown in Table 2.1. 

Table 2.1 Operations of Enlargement, Shrink, Rotation and Translate  

            (two buttons with windows) 

Action Operation 

Enlargement Hold down the Alt key while clicking the left mouse button , 

move the mouse pointer down. 

Shrink Hold down the Alt key while clicking the left mouse button, 

move the mouse pointer up. 

Rotation Hold down the left mouse button, and move the mouse pointer 

in the direction you want to rotate. 

Translate Hold down the right mouse button, and move the mouse 

pointer in the direction you want to move. 

 

2.9.2. Coordinate Rotation and Translation of Molecule Structure  

The coordinate rotation and translation of molecule structures each file can be input by 

typing. This operation modifies the coordinates of molecule structures in the files as 

subjects, and is available for the editing of molecule structures. 

The mark which shows the translation direction are displayed at the midpoint  

of rotation like an example on the right. Key binds are 

Translation x direction (－:z＋:x), y direction( －:c＋:v), z direction(－:b＋:n) 

Rotation x axis (－:a＋:s), y axis (－:d＋:f), z axis(－:g＋:h). 

The coordinate of the atom is modified when it is rotated and translated.  

As for the translation, you can move the coordinate of the atom by 0.1Å each time 

you press the key.  To translate it by 0.5Å, hold down the Shift key, and to translate it 

by 1.0Å, hold down the Ctrl key.  As for the rotation, you can rotate it through 1°each 

time you press the key.  To rotate it through 5, hold down the Shift key, and to move it 

through45, hold down the Ctrl key.  

When you input files, the center of the rotation is that of the gravity of the whole 

atoms.  The coordinate of the particular atom can be the center of rotation. To make 

the position of an atom the center of rotation, click on the atom and select [Set File 

Rotation Center] under [Tool] menu.  

Without selecting, the center of rotation is set to that of the gravity of each atom by 

selecting [Set File Rotation Center] under [Tool] menu.  

 

z x 

c 

v 
n 

b 
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2.9.3. Control of visualization area 

You can control visualization area by mouse wheel operation. Example is shown 

Fig2.128. The operation controls the clip distance before and after the display according 

to the amount of movement of the mouse wheel. In this way it will not be displayed 

except the designated range. Just turn the wheel, then clip the front area, turn the 

wheel with Shift-key pressed, then clip the back area. Clip volume is 0.1 times by 

pressing with Control-key. With pressed Alt-key, then reset clip area. 

 

 

upper: standard, lower : clip front and back 

Fig2.128 Example of control clip area. 
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2.10. How to Select Structures as Subjects 

  When you click on molecular structures on viewing-window, the atom’s information is 

shown in a message area.  And the structures as subjects are added colors in yellow 

and highlighted in hierarchical window.  Click on an atom or a residue and click on 

another one while holding down the Shift key to select the intervening ones.  Click on 

an atom or a residue while holding down the Ctrl key to add it.  This example of a 

display is shown in Fig2.129. 

  By clicking on names of a residue and an atom in hierarchical window, they can be 

selected.  They are displayed in yellow on 3D view-window.   Click on an atom or a 

residue and click on another one while holding down the Shift key to select the 

intervening ones.  Click on an atom or a residue while holding down the Ctrl key to 

add it.  

 

 

Fig2.129 Example of Selected Atoms 
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2.11. Setting Preference Categories 

  In the case that you click on atoms or residues with the right button on the mouse, the 

pop-up dialog box appears to specify each category: Display, Model, Color and Label. 

Atoms dialog box is shown in Fig2.130 and Residues dialog box in Fig2.131.  By 

clicking on the atom or residue in hierarchical window with the left button on the mouse 

and clicking on it with the right button on the mouse, the dialog box is displayed as well. 

This assignment apply to the Atom and Structure. 

 

Display : Specify the display, on or off 

Model : In the case of residues, select the display model from None, Wire Frame, Eire 

Frame with Fragment Bond, Ball & Stick, Stick, Ball & Wire and CPK.  When 

you select None, the residue is displayed in the model specified in the menu bar.   

Label: Specify a label.  In the case of atoms, the names and numbers can be selected. In 

the case of residues, the names and the names with numbers can be selected 

Color: Select the display color from None, Atom, Residue, Charged Residue, Atom 

Charge, Fragment, Interaction Energy, Interaction Energy[lock], Chain, File and 

Other. When you select None, the residue is displayed in the color selected in the 

menu bar. In the case of Other, setting colors are displayed beside the button.  

By clicking on it, a color preference dialog box is displayed.  

 

Fig2.130 Display Atom Dialog Box 

 

Fig2.131 Display Residues Dialog Box 



101 

2.12. Setting the Bounding box 

The bounding box can be displayed using MOL2 file. Type “grid. file” above 

@<TRIPOS>ATOM and type the top of the coordinate with the proper atom.  Specify 

the line which you want to display with @<TRIPOS>BOND, in the index, then.   An 

example of the display is shown as follows.  

 

Fig2.132 Domain of Analysis Display 

  



102 

@<TRIPOS>MOLECULE 

test data 

    8   12    0 

    0    0    0    0 

 

 

grid file 

@<TRIPOS>ATOM 

       1 N     -8.0000   -4.0000   -9.0000 N.4     1  GLY         0.0000 

       2 N      8.0000   -4.0000   -9.0000 N.4     1  GLY         0.0000 

       3 N     -8.0000   -4.0000    4.0000 N.4     1  GLY         0.0000 

       4 N      8.0000   -4.0000    4.0000 N.4     1  GLY         0.0000 

       5 N     -8.0000   18.0000   -9.0000 N.4     1  GLY         0.0000 

       6 N      8.0000   18.0000   -9.0000 N.4     1  GLY         0.0000 

       7 N     -8.0000   18.0000    4.0000 N.4     1  GLY         0.0000 

       8 N      8.0000   18.0000    4.0000 N.4     1  GLY         0.0000 

@<TRIPOS>BOND 

       1        1        2 1 

       2        2        4 1 

       3        3        4 1 

       4        3        1 1 

       5        5        6 1 

       6        6        8 1 

       7        7        8 1 

       8        7        5 1 

       9        1        5 1 

      10        2        6 1 

      11        3        7 1 

      12        4        8 1 

Fig2.133 Example of files for the Bounding box(g10a_grid.mol2) 
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2.13. Molda 

This section describes Creation DNA/RNA, Mutation DNA/RNA, and Adding Nucleotide 

DNA/RNA. Refer to Molda Users Guide about other Molda. 

 

2.13.1. Creation DNA  

(1) Molda Menu 

Input DNA/RNA, Mutation DNA/RNA and Add Nucleotide DNA/RNA are added to 

Model menu. 

 

Fig2.134 Molda Menu 

(2) Input DNA sequence 

Select [Molda]-[Input]-[DNA] menu. The menu is shown in Fig2.135. Create DNA dialog 

box is displayed and shown in Fig2.136. For instance, input AAGGCCTT to the text 

area of the dialog box as Input sequence and click OK. The text area has to input 

DNA-bases: A, G, C and T. The result is displayed on Molda viewer and shown in 

Fig2.137. The other chain will be created automatically. 

 

Fig2.135 Input DNA menu 
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Fig2.136 Create DNA dialog box 

 

Fig2.137 Result of create DNA 
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(3) To Viewer 

If you want to display the DNA on BioStation main window then select [Display]-[To 

Viewer] menu. The DNA is displayed on BioStation main window. Result of display is 

shown in Fig2.138. 

 

Fig2.138 Result of display DNA on BioStation viewer 
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2.13.2. Creation RNA  

(1) Input RNA sequence 

Select [Molda]-[Input]-[RNA] menu. The menu is shown in Fig2.139. Create DNA dialog 

box is displayed and shown in Fig2.140. For instance, input AAGGCCUU to the text 

area of the dialog box as Input sequence and click OK. The text area has to input 

RNA-bases: A, G, C and U. The result is displayed on Molda viewer and shown in 

Fig2.141. 

 

Fig2.139 Input RNA menu 

 

Fig2.140 Create RNA dialog box 
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Fig2.141 Result of create RNA 

(2) To Viewer 

If you want to display the RNA on BioStation main window then select [Display]-[To 

Viewer] menu. The RNA is displayed on BioStation main window. Result of display is 

shown in Fig2.142. 

 

Fig2.142 Result of display RNA on BioStation viewer 
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2.13.3. Mutation DNA  

(1) Display DNA on BioStation 

Open pdb file of DNA on BioStation Viewer. 

 

Fig2.143 Result of display pdb file of DNA on BioStation viewer 

(2) Display on Molda 

Display the DNA on Molda. Select [File]-[Molda [with file]] menu of BioStation Viewer. 

The DNA is displayed on Molda. It is shown in Fig2.144. 

 

Fig2.144 Result of display DNA on Molda 
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(3) Select nucleotide 

Select [View]-[Sequence Viewer] menu and Sequence Viewer is displayed. Select a 

mutated nucleotide and click OK on Sequence Viewer. The selected nucleotide changes 

the color to cyan on Molda. For instance, select DC3 and click OK on Sequence Viewer. 

It is shown in Fig2.145 and Molda is shown in Fig2.146. 

 

Fig2.145 Selected DC3 on Sequence Viewer 

 

Fig2.146 Selected DC3 on Molda 
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(4) Mutate DNA 

Select [Molda]-[Point Mutation]-[DNA] menu. The menu is shown in Fig2.147. 

Mutation DNA dialog box is displayed and shown in Fig2.148. If selected DC3 in (3) 

mutate into DT then select DT from the combo box of the dialog box and click OK. The 

combo box has DNA-bases: DA, DG, DC and DT. The result is displayed on Molda 

viewer and shown in Fig2.149. 

 

Fig2.147 Point Mutation DNA menu 

 

Fig2.148 Point Mutation DNA dialog box 

 

Fig2.149 Result of Mutation DNA 
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(5) To Viewer 

If you want to display the DNA on BioStation main window then select [Display]-[To 

Viewer] menu. The DNA is displayed on BioStation main window. Result of display is 

shown in Fig2.150. 

 

Fig2.150 Result of display DNA on BioStation viewer 
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2.13.4. Mutation RNA  

(1) Display RNA on BioStation 

Open pdb file of RNA on BioStation Viewer. 

 

Fig2.151 Result of display pdb file of RNA on BioStation viewer 

(2) Display Molda 

Display the RNA on Molda. Select [File]-[Molda [with file]] menu of BioStation Viewer. 

The RNA is displayed on Molda. It is shown in Fig2.152. 

 

Fig2.152 Result of display RNA on Molda 
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(3) Select nucleotide 

Select [View]-[Sequence Viewer] menu and Sequence Viewer is displayed. Select a 

mutated nucleotide and click OK on Sequence Viewer. The selected nucleotide changes 

the color to cyan on Molda. For instance, select U2 and click OK on Sequence Viewer. It 

is shown in Fig2.153 and Molda is shown in Fig2.154. 

 

Fig2.153 Selected U2 on Sequence Viewer 

 

Fig2.154 Selected U2 on Molda 
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(4) Mutate RNA 

Select [Molda]-[Point Mutation]-[RNA] menu. The menu is shown in Fig2.155. Mutation 

RNA dialog box is displayed and shown in Fig2.156. If selected U2 at (3) mutate into A 

then select A from the combo box of the dialog box and click OK. The combo box has 

RNA-bases: A, G, C and U. The result is displayed on Molda viewer and shown in 

Fig2.157. 

 

Fig2.155 Point Mutation RNA menu 

 

Fig2.156 Point Mutation RNA dialog box 

 

Fig2.157 Result of Mutation RNA 
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(5) To Viewer 

If you want to display the DNA on BioStation main window then select [Display]-[To 

Viewer] menu. The RNA is displayed on BioStation main window. Result of display is 

shown in Fig2.158. 

 

Fig2.158 Result of display RNA on BioStation viewer 
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2.13.5. Adding Nucleotides of DNA  

In the Adding Nucleotides of DNA you can choose position from 5’Terminal, 3’Terminal 

and Middle. This section describes each positions. 

2.13.5.1 Position：5’Terminal 

If you want to Adding Nucleotides in 5'-end direction then select 5’Terminal. 

(1) Display DNA on BioStation 

Open pdb file of DNA on BioStation Viewer. The following display properties are setting 

for describing: [Model]-[Atom (A)] sets Off, [Model]-[Structure(S)] sets Cα[line], and 

[Tool]-[Label]’s Residue Label sets on. 

For instance, if a base pair of B chain’s DC9 is missing then add DG in 5'-end direction 

as next to DA1 on A chain. 

 

Fig2.159 Result of display pdb file of DNA on BioStation viewer 
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(2) Display Molda 

Display the DNA on Molda. Select [File]-[Molda [with file]] menu of BioStation Viewer. 

The DNA is displayed on Molda. It is shown in Fig2.160. 

 

Fig2.160 Result of display DNA on Molda 

(3) Select starting DNA-base for Add 

Select [View]-[Sequence Viewer] menu and Sequence Viewer is displayed. Select a 

stating nucleotide and click OK on Sequence Viewer. The selected nucleotide changes 

the color to cyan on Molda. For instance, select DA1 and click OK on Sequence Viewer. 

It is shown in Fig2.161 and Molda is shown in Fig2.162. 

 

Fig2.161 Selected DA1 on Sequence Viewer 
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Fig2.162 Selected DA1 on Molda 
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(4) Adding Nucleotide 

Select [Molda]-[Add Nucleotide]-[DNA] menu. The menu is shown in Fig2.163. DNA 

Adding Nucleotide dialog box is displayed and shown in Fig2.164. If DG adds next to 

DA1 in 5’-end direction then choose 5’Terminal from Position, input G to the text area 

as Sequence and click OK. Sequence has to input DNA-bases: A, G, C and T. The result 

is displayed on Molda viewer and shown in Fig2.165. 

 

Fig2.163 DNA Add Nucleotide menu 

 

Fig2.164 DNA Add Nucleotide dialog box 
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Fig2.165 Result of DNA Adding Nucleotide 

Remark 

・ If selected chain in (3) has only one DNA-base then it doesn’t allow you to add 

any nucleotides to the chain. 

・ If the Position selects 5’Terminal then selected DNA-base in (3) has to be on 

5’-end. 
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(5) To Viewer 

If you want to display the DNA on Molda to BioStation main window then select 

[Display]-[To Viewer] menu. The DNA is displayed on BioStation main window. Result 

of display is shown in Fig2.166. 

 

Fig2.166 Result of display DNA on BioStation viewer 
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2.13.5.2 Position：Middle 

If you want to add nucleotides in 3'-end direction and selected DNA-base isn’t on 3’-end 

then select Middle. 

(1) Display DNA on BioStation 

Open pdb file of DNA on BioStation Viewer. The following display properties are setting 

for describing: [Model]-[Atom (A)] sets Off, [Model]-[Structure(S)] sets Cα[line], and 

[Tool]-[Label]’s Residue Label sets on. 

For instance, if two base pair of A chain’s DG2 and DC3 are missing then add DG and 

DC in 3'-end direction as next to DA5 on B chain. 

 

Fig2.167 Result of display pdb file of DNA on BioStation viewer 
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(2) Display Molda 

Display the DNA on Molda. Select [File]-[Molda [with file]] menu of BioStation Viewer. 

The DNA is displayed on Molda. It is shown in Fig2.168. 

 

Fig2.168 Result of display DNA on Molda 
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(3) Select starting DNA-base for Adding 

Select [View]-[Sequence Viewer] menu and Sequence Viewer is displayed. Select a 

stating nucleotide and click OK on Sequence Viewer. The selected nucleotide changes 

the color to cyan on Molda. For instance, select DA5 and click OK on Sequence Viewer. 

It is shown in Fig2.169 and Molda is shown in Fig2.170. 

 

Fig2.169 Selected DA5 on Sequence Viewer 

 

Fig2.170 Selected DA5 on Molda 
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(4) Add Nucleotide 

Select [Molda]-[Add Nucleotide]-[DNA] menu. DNA Add Nucleotide dialog box is 

displayed and shown in Fig2.171. For instance, if DG and DC adds next to DA5 in 3’-end 

direction then choose Middle from Position, input GC to the text area as Sequence and 

click OK. Sequence has to input DNA-bases: A, G, C and T. The result is displayed on 

Molda viewer and shown in Fig2.172. 

 

Fig2.171 DNA Add Nucleotide dialog box 

 

Fig2.172 Result of DNA Adding Nucleotide 
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Remark 

・ If selected chain in (3) has only one DNA-base then it doesn’t allow you to add 

any nucleotides to the chain. 

・ If the Position selects Middle then selected DNA-base in (3) has to be on 5’-end 

or middle, not on 3’-end. 

・ If the Position selects Middle then add nucleotides equal or less than number of 

missing nucleotides. 

 

(5) To Viewer 

If you want to display the DNA on BioStation main window then select [Display]-[To 

Viewer] menu. The DNA is displayed on BioStation main window. Result of display is 

shown in Fig2.173. 

 

Fig2.173 Result of display DNA on BioStation viewer 
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2.13.5.3 Position：3”Terminal 

 

If you want to add nucleotides in 3'-end direction and selected DNA-base is on the 3’-end 

then select Middle. 

(1) Display DNA on BioStation 

Open pdb file of DNA on BioStation Viewer. The following display properties are setting 

for describing: [Model]-[Atom (A)] sets Off, [Model]-[Structure(S)] sets Cα[line], and 

[Tool]-[Label]’s Residue Label sets on. 

For instance, if a base pair of B chain’s DA4 is missing then add DT in 3'-end direction 

as next to DG3 on A chain. 

 

Fig2.174 Result of display pdb file of DNA on BioStation viewer 
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(2) Display Molda 

Display the DNA on Molda. Select [File]-[Molda [with file]] menu of BioStation Viewer. 

The DNA is displayed on Molda. It is shown in Fig2.175. 

 

Fig2.175 Result of display DNA on Molda 
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(3) Select starting DNA-base for Adding 

Select [View]-[Sequence Viewer] menu and Sequence Viewer is displayed. Select a 

stating nucleotide and click OK on Sequence Viewer. The selected nucleotide changes 

the color to cyan on Molda. For instance, select DG3 and click OK on Sequence Viewer. 

It is shown in Fig2.176 and Molda is shown in Fig2.170. 

 

Fig2.176 Selected DG3 on Sequence Viewer 

 

Fig2.177 Selected DG3 on Molda 
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(4) Add Nucleotide 

Select [Molda]-[Add Nucleotide]-[DNA] menu. DNA Add Nucleotide dialog box is 

displayed and shown in Fig2.178. For instance, if DG and DC adds next to DG3 in 3’-end 

direction then choose 3’Terminal from Position, input T to the text area as Sequence 

and click OK. Sequence has to input DNA-bases: A, G, C and T. The result is displayed 

on Molda viewer and shown in Fig2.179. 

 

Fig2.178 DNA Add Nucleotide dialog box 

 

Fig2.179 Result of DNA Adding Nucleotide 
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Remark 

・ If selected chain in (3) has only one DNA-base then it does not allow you to add 

any nucleotides to the chain. 

・ If the Position selects 3’Terminal then selected DNA-base in (3) has to be on the 

3’ -end. 

・ If the Position selects 3’Terminal and the selected nucleotide dose not have 

previous nucleotide, first add missing nucleotides by Middle and then add 

nucleotides in 3’-end direction on the 3’-end. 

 

(5) To Viewer 

If you want to display the DNA on BioStation main window then select [Display]-[To 

Viewer] menu. The DNA is displayed on BioStation main window. Result of display is 

shown in Fig2.180. 

 

Fig2.180 Result of display DNA on BioStation viewer 
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2.13.6. Adding Nucleotides of RNA 

 

Adding Nucleotide of RNA’s operations are same as DNA’s. 

This section describes Adding Nucleotide of RNA when the Position is chosen Middle. 

(1) Display RNA on BioStation 

Open pdb file of DNA on BioStation Viewer. The following display properties are setting 

for describing: [Model]-[Atom (A)] sets Off, [Model]-[Structure(S)] sets Cα[line], and 

[Tool]-[Label]’s Residue Label sets on. 

For instance, if between G3 and C8 nucleotides are missing then add three nucleotides 

in 3'-end direction as next to G3. 

 

Fig2.181 Result of display pdb file of RNA on BioStation viewer 
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(2) Display Molda 

Display the DNA on Molda. Select [File]-[Molda [with file]] menu of BioStation Viewer. 

The DNA is displayed on Molda. It is shown in Fig2.182. 

 

Fig2.182 Result of display RNA on Molda 



134 

(3) Select starting RNA-base for Adding 

Select [View]-[Sequence Viewer] menu and Sequence Viewer is displayed. Select a 

stating nucleotide and click OK on Sequence Viewer. The selected nucleotide changes 

the color to cyan on Molda. For instance, select G3 and click OK on Sequence Viewer. It 

is shown in Fig2.183 and Molda is shown in Fig2.184. 

 

Fig2.183 Selected G3 on Sequence Viewer 

 

Fig2.184 Selected G3 on Molda 
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(4) Add Nucleotide 

Select [Molda]-[Add Nucleotide]-[DNA] menu. The menu is shown in Fig2.185. DNA 

Add Nucleotide dialog box is displayed and shown in Fig2.186. For instance, if A, G and 

U add next to G3 in 3’-end direction then choose Middle from Position, input AGU to the 

text area as Sequence and click OK. Sequence has to input RNA-bases: A, G, C and U. 

The result is displayed on Molda viewer and shown in Fig2.187. 

 

Fig2.185 RNA Add Nucleotide menu 

 

Fig2.186 RNA Add Nucleotide dialog box 
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Fig2.187 Result of RNA Adding Nucleotide 

Remark 

・ If selected chain in (3) has only one RNA-base then it dose not allow to add any 

nucleotides to the chain. 

・ If the Position selects 5’Terminal then selected RNA-base in (3) has to be on the 

5’-end. 

・ If the Position selects Middle then selected RNA-base in (3) has to be on the 

5’-end or middle, not on the 3’-end. 

・ If the Position selects Middle then add nucleotides equal or less than number of 

missing nucleotides. 

・ If the Position selects 3’Terminal then selected RNA-base in (3) has to be on the 

3’-end. 

・ If the Position selects 3’Terminal and the selected nucleotide dose not have 

previous nucleotide, first add missing nucleotides and then add nucleotides in 

3’-end direction on the 3’-end. 
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(5) To Viewer 

If you want to display the RNA on BioStation main window then select [Display]-[To 

Viewer] menu. The RNA is displayed on BioStation main window. Result of display is 

shown in Fig2.188. 

 

Fig2.188 Result of display RNA on BioStation viewer 
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3. Examples of How to use 

3.1. Displaying the Results of ABINIT-MP Calculations.  

Use the sample data which is operating at the Web site of ABINIT-MP 

(http://www.fsis.iis.u-tokyo.ac.jp/en).   The sample data are  

o the sample data of ( Gly) 10  g10a.zip 803 KB, 

 g10a.cpf, Check point file of the FMO-HF/STO-3G calculation 
 den.inp, input data for the calculation of the electron density  
 g10a_fmo_sto-3g_3.den , grid data of the electron density  
 g10a_fmo_sto-3g_3.map ,electrostatic potential map data on the 

electron density  
 g10a_fmo_sto-3g_4.esp , grid data of electron potential  
 g10a_fmo_sto-3g_3.mo , grid data of molecular orbitals  
 g10a_grid.mol2, data file of a display example for the domain 
 g10a_fmo_sto-3g_3.efv, grid data of electron field vector  

3.1.1. Displaying Molecular Structures 

Start the Viewer and load g10a.cpf . An example of this display is shown in Fig3.1.  

When the Viewer is started, molecular structures are displayed in the wire frame 

model. 

 

Fig3.1 Example of Display: g10a.cpf  

From the Model menu, select Wire frame, Wire frame(with fragment bond)(specifying 

frame for colors),Ball & Stick, Ball & Wire, CPK, Backbone, C, Ca (line) and C(tube) 

to  modify the model.  Here are the resulting displays in Fig3.2- Fig3.8 
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         Fig3.2 Wire Frame      Fig3.3 Wire frame model(with fragment bond) 

  

     Fig3.4 ball and stick             Fig3.5  Ball & Wire model 
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Fig3.6 CPK                   Fig3.7  Backbone model   

 

Fig3.8  CLine model 
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3.1.2.  Changing Colors 

From the Color menu, select Atom, Residue, Charged Residue, Atom Charge, 

Fragment, and Chain to change the display color.  Here are the resulting displays in 

Fig3.9-Fig3.13. 

  

Fig3.9 Adding Colors by Atom Type  Fig3.10 Adding Colors by Residues 

   

Fig3.11 Adding Colors by residue Charge  Fig3.12 Adding Colors by Chrges Atoms 
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Fig3.13 Adding Colors by fragment  Fig3.14 Adding Colors by Chains ( one color 

with one chain) 

 

Fig3.15 Adding Colors by the Interaction Energy between Fragments. The Second 

Fragment in Yellow is Displayed as a Reference. 



143 

3.1.3. Adding Labels 

When you select [Tool]-[Label], a dialog box to add labels is displayed.  Fig3.16 shows 

an example with labels of residues in, and Fig. 3.19 shows it with those of atoms.  

   

Fig3.16  Residue Lables  Fig3.17 Molecules with Labels of Atoms ( names of 

atoms)  
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3.1.4. Displaying the Isosurface of the Electron Density 

  Load g10a_fmo_sto-3g_3.den with [File]- [Open]. A dialog box for the isosurface  

is displayed, which value is generated in the file.  Clicking on the Ok button lets 

the isosurface of the electron density display. The example is shown in Fig3.18. 

Select [File]–[File List], and the list of input files is displayed.  Here, click on the Value 

button beside g10a_fmo_sto-3g_3.den.   Since a dialog box for the isosurface value is 

displayed, change colors.  When you click on the button beside Color, a color preference 

dialog box is displayed.  Here, select the appropriate color.  The example is shown in 

Fig3.19.  

     

Fig3.18 Isosurface Fig3.19 Isofurface with the Color 

Changed

 

When you select [File]–[Delete File List], the list of input files is displayed.  Here, 

select g10a_fmo_sto-3g_3.den and click on the Ok button.  The isofurface is deleted.   
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3.1.5. Adding Colors to the Isosurface of the Electron Density by the Value of 

Electrostatic Potentia. 

Load g10a_fmo_sto-3g_3.map with [File]- [Open].  An electrostatic potential dialog 

box appears on the screen.  Set Min Max to -0.05 0.05.  Clicking on Ok lets the 

isofurface of the electron density display.  This example is shown in Fig3.20. 

You can change the transparency of the isosurface.  Selecting [File]–[File List] lets 

the list of the input file displayed. Here, click on the Value button beside  

g10a_fmo_sto-3g_3.map.  Since electrostatic potential dialog box is displayed, set 

Transparency to 50.  Select [Color]–[Atom]–[Charge]–[Atom] as well.  This example is 

shown in Figure 3.23. 

   

Fig3.20 Adding Colors to the Isosurface of 

the Electron Density by the Value of 

Electrostatic Potential 

Fig3.21 Changed the Transparency of 

Isosurface
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3.1.6. Isosurface of Electrostatic Potential  

  Load g10a_fmo_sto-3g_4.esp with [File]-[Open].  An electrostatic potential dialog 

box is displayed.  When you set Transparency to 50 and click on the Ok button, the 

isofurface value of electrostatic potential is displayed.  The example of molecule 

structures with Stick is shown in Fig3.22.   

 

 

Fig3.22 Isosurface of Electrostatic Potential 
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3.1.7.  Isosurface of Molecular Orbitals 

  Load g10a_fmo_sto-3g_3.mo with [File]- [Open]. A molecular orbital dialog box is 

displayed.  Here, when you select an orbital that you want to display from the graphic 

and click on draw, the isosurface of the molecular orbital is displayed.   This example 

shows the isosurface of the first fragment, LUMO, which is shown in the Fig3.23. 

 

 

 

Fig3.23 Isosurface of Molecular Orbitals 
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3.1.8. Electron field vector 

Load g10a_fmo_sto-3g_4.efv with [File]-[Open]. Display the electron field vector by 

default options. （Fig3.24） 

Next is a example which changes options. Min,Maxの値を-0.1,0.1にします。Set section 

options to, B set –27 and select Density for value.By clicking Draw button, the section is 

displayed(Fig3.26). An option dialog is shown in Fig3.25.  

Set the next Model of molecular structure to Ball&Stick, transparency to 50,  model 

of vector to Stick and Number of step to 150. by Clicking Draw button, an example of 

stick vector is displayed(Fig3.28). Since the number of steps was increased, an electric 

field vector is displayed from lower Glycine(+) to upper Glycine(-). 

 

 

Fig3.24 Example of electron field vector 
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Fig3.25 Section dialog box 

 

Fig3.26 Example of vector with section 
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Fig3.27 Electron field vector dialog box 

 

Fig3.28 Example of stick vector 
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3.2. Example of Structures of Estrogen Receptors – Ligand Complexes  

Visualizing structures with using sample data.  Use estrogen receptors- ligand 

complexes as the sample data, located in the folder, sample.  Use the pdb file, 

ERE_EST.pdb and ERR_RAL.pdb, of the bond between an agonist as a ligand, 17β

-estradiaol and a selective agonist, raloxifene.  

 

3.2.1. Peptide Chains in the the C Line Model 

Start the Viewer and load ERE_EST.pdb. Default model is [Model(Atom)]-[Off], 

[Model(Structure)]- [Cα Line]. This example is shown in Fig3.29. 

The another model examples are shown in Fig2.29-Fig2.35. 

 

Fig3.29 Molecular Structures  
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3.2.2.  Modifying the model of C Line of Peptide and the model of Ligands  

Select [Selection]-[Residue] and click on the ligand with the left mouse button.  Fig3.30 

shows an example of the highlighted a ligand which you click. 

 

 

Fig3.30  Highlighted a Ligand  
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Next, click on the ligand by the right mouse button.  Since a dialog box for specifying 

residues is displayed, select Atom in the Color and Ball & Stick in the Model option and 

click on the Ok button. (Fig3.31) This allows you to display a ligand in the Ball & Stick 

model.  This example is shown in Fig3.32. 

 

Fig3.31 Displaying Residue Dialog Box 

 

Fig3.32  Ligand in the Ball & Stick Model  
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Next, click on the ligand with the right mouse button and select CPK in the Model 

option of the residue dialog box.  Set other in the Color option and select the 

appropriate color by clicking on the side button.  The ligand is displayed with colors 

selected in the space-filling model. This example is shown in Fig3.33.  

 

 

Fig3.33 Ligand in the Space Filling Model  
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3.2.3. Display Peptide Chains in the CLine Model+ Ligands+ Selected Residues  

You can display residues around ligands in the Wire Frame model.  Click on the four 

residues around ligands ( ASN519～GLU523 in this example ) with the left button on 

the mouse while holding down the Shift.  Click on the one of them with the right mouse 

button while holding down the Shift.  Since the Residue dialog box is displayed, select 

Wire Frame in the Model and click on the Ok button.  This displays the selected 

residues in the Wire Frame model.  This example is shown in Fig3.34.  

 

 

Fig3.34 Selected Residues in the Wire Frame 
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Next, you can change the display from hierarchical window.  Click on residues 

around ligands.  Since the selected residues in hierarchical window are highlighted, 

click on  beside the names of residues and close the current display of the residues.  

And then, click on this residue again and the residue below five ones (GLY420～

PHE425 in this example ) while holding down the Shift.  Here, some residues are 

selected.  Next, click on the selected residues with the right button on the mouse.  

Since the Residue dialog box is displayed, select Wire Frame in the Model and click on 

the Ok button.  This displays the selected residues in the Wire Frame model.  This 

example is shown in Fig3.35.  

 

Fig3.35 Residues Selected in Tree figure in the Wire Frame Model   
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3.2.4.  Display Ligands and Charged Residues  

You can display the whole residues in the Wire Frame model by selecting 

[Model(Atom)]-[Wire Frame] and [Model(Structure)]-[Off].  Select [Tool]-[Display 

Selected Residue]. Since the residue dialog box appears, click on Unselect All and select 

charged residues (ASP,GLU,LYS,ARG).  This allows you to display the only charged 

residues which you select.   This example is shown in Fig3.36.  The only residue 

which is selected optionally can be displayed as well.   

 

 

Fig3.36 Charged Amino Acid  
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When you select [Color(Atom)]-[Charged Residue], the displayed residues are added 

colors by the charged values.  This example is shown in Fig3.37.  

 

Fig3.37 Residues Added Colors by Charged Amino Acid  

Select [Tool]-[Display Selected Residue].  Since the residue dialog box appears, click on 

Select All.  The setting of residues is unspecified, which displays the whole residues.  

This example is shown in Fig3.38.  

 

Fig3.38 All the Residues Added Colors by Charged Amino Acid  
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3.2.5.  Display Atoms around Ligand in specified Distance 

Click on the ligand and select [Tool]-[Display Atom in Distance].  Since the dialog box 

for the assignment of a distance appears, select Residue from From selected and input 4 

in the Distance.  And then, atoms within 4Å from the ligand are displayed.  This 

example is shown in Fig3.40. Here, click on the atom around the center of the ligand 

and select [Tool]-[Set Rotation Center].  This makes you move the display easier, since 

the center of the rotation can be the selected atom.   

 

Fig3.39 Atoms in the Distance Dialog Box 

 

Fig3.40 Atoms within the Distance 
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Next, you can display the distance between atoms.  Select [Color]-[Atom] to set colors 

to the whole atoms.  Click on the ligand with the right button on the mouse and set it 

in the Ball & Stick model.  Here, select [Monitor]-[Distance].  Click on the hydrogen 

of a side of the ligand.  Next, click on the nearby oxygen.  This displays the distance 

between the atoms in the message area.  This example is displayed in Fig3.41.  

 

 

Fig3.41 Distance between the Atoms  
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3.3. Example of the Display of Interaction Energy between Fragments 

Use the result of computations of the estrogen receptor – the ligand complex.  With 

the calculation as 1fragment = 1 residue, the interactions between residues and 

between residues and ligands can be displayed.  

 

3.3.1. Load File 

Start the Viewer and load ERD_EST.cpf.  This display is shown in Fig3.42.  

 

 

Fig3.42 Molecular Structure from the Input File  
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3.3.2. Assignment of Interaction Energy between Fragments 

Click on a ligand, EST600, in hierarchical window with the left mouse button. Select 

[Monitor]-[Interfragmnet Interaction]-[1:1]  and popup the dialog box for the values of 

interaction energy (Fig3.43.).   Here, type min:-10, max:10 and click on the Ok button.  

This allows you to display molecular structures, which are added colors to the 

interaction energy between each residue from ligands within the range,  -10～

10kcal/mol.  An example of the display is shown in Fig3.44.  

 

Fig3.43 Interaction Energy between Fragments Dialog Box 

 

Fig3.44 Interaction Energy between Fragments Display 
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3.3.3. Assignment of Threshold  

To highlight ligands, a display attribute dialog box is displayed by clicking on ＥＳＴ

600 in hierarchical window with the right mouse button.  Here, click on the button in 

the Color to select the proper color and specify CPK in the Model (Fig3.45)  Next, select 

[Monitor]-[Interfragment Interaction]-1:1[lock] and put 2 in the threshold at the dialog 

box for values.  This makes it impossible to display residues with absolute values of the 

interaction energy under 2kcal/mol.  An example of the display is shown in Fig3.46.  

 

Fig3.45 Display Attribute for Ligands Dialog Box 

 

Fig3.46 Interaction Energy between Fragments, Specifyed Threshold Display 
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3.3.4. Interaction Energy between Selected Fragments 

Select [Model(Atom)]-[Stick].  Select [Monitor]-[Interaction Energy].  Menu is 

displayed in green until this menu is selected again.  And by selecting the display, the 

interaction energy between selected fragments (residues) is displayed.  An example of 

the display by clicking on the ligands and fragments around them is shown in Fig3.47.  

In addition, the interaction energy list between fragments (residues) can be displayed 

as Fig2.61. 

 

 

Fig3.47 Interaction Energy between Selected Fragments Display 
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3.4. How to Overlay 

Use data of ERE_EST.cpf and ERR_RAL.cpf to overlay. 

 

3.4.1. Load File 

Start the Viewer and select [Model(Structure)]-[C, [Color(Structure)]-[File] and 

load ERE_EST.cpf , ERR_RAL.cpf.  This allows you to set colors to the molecules each 

file.  An example of the display is shown in Fig3.48. 

 

Fig3.48 Two Molecules Load from the Files  
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3.4.2. Overlay with All the CCoordinate  

Select [Tool]-[Overlay Molecules].  Popup A dialog box for the overlay.  As you use the 

default value, click on the Ok button.  In the default, overlay the molecules each file 

with the C  coordinate.  An example of a display after the overlay is shown in Fig3.49. 

Since all over the molecules are overlaid, they are not lined up on the whole.  

 

 

Fig3.49 Molecules Overlaid Each File with the C Coordinate  

3.4.3. Overlay by Atom(C within Selected Residues)  

Next, you can overlay molecules by selecting 3 atoms(C .  Select [Tool]-[Overlay 

Molecules].  Set Residue in the Type, and C  in the Method.  Click on 3 parts of each 

residue, which is similar to each other structurally by turns.  The residue numbers, 

which you click are displayed in the input field, where you can modify them by using the 

key board.   In the case that you put the wrong number, it can be deleted by the 

keyboard.  This dialog box is shown in Fig3.50.  Here, click on the Ok button.  

Display both ligands (EST600 and RAL600) in the Stick model.  You can see the 

difference of the position of Herix 12 in the end side, C, of both agonist (EST pink) and 

antagonist (RAL purple).(Fig3.51) 
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Next, select [Model]-[C{tube}].  An example of the display is shown in Fig3.52. 

 

Fig3.50 Overlay Molecules Dialog Box 

 

Fig3.51 The Result of Molecules Overlaid by Selected Residues 
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Fig3.52 The Result of Molecules Overlaid by Selected Residues (C{tube}) 
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3.5. Example of How to Add Hydrogen 

Use a sample file (ERE_EST_noH.pdb) with hydrogen removed in advance.  In order 

to add hydrogen, Reduce needs to be preconditioned to be installed.   Refer to the 

setting of Reduce in Section 4.5 so as to install. 

Load ERE_EST_noH.pdb and select [Tool]-[Add Hydrogen].  Popup a dialog box to 

add hydrogen. (Fig3.53).  Input file name added _addH is displayed in the output file 

field as a default.  In the Options, ｓet options which can be used in Reduce. By click on 

the Ok button, a display of a command prompt is displayed to appear a log for the 

execution.  Input exit to close the window.(Fig3.54)  

 

Fig3.53 Add Hydrogen Dialog  

 

Fig3.54 Command Prompt Window 
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When you close the command prompt, you could be asked if you want to display the 

result or not.  Here, clicking on the Ok button lets the display replace it with added 

hydrogen.  

 

Fig3.55 Confirmation of Displaying the Result 

 

 

Fig3.56 Molecule Structure Added Hydrogen 
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3.6. Example of Interfragment interaction energy N:1 

Display an example of Interfragment interaction energy N:1  using of the  

calculation results of DNA and protein. By load a sample file, 

trunc-DB7_Hopt_moe_DNA.cpf, display molecular structures with the Cα[tube] model. 

By selecting [Monitor]- [Interfragment Interaction]-[N:1], pop up a dialog box. This data 

consist of protein(fragment number 23-222), lagend (223) and DNA(1-22). In order to 

show Interaction energy between protein, ligand and DNA, input 23-223 for the Base 

fragment, and set Min,Max to -100,100, By clicking on OK button, protein, ligand and 

DNA are colored by the value of interaction energy. Red parts are stable relations. 

 

 

Fig3.57 Example of Interfragment interaction energy N:1 
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3.7. Example of trajectory 

3.7.1. Glyine 

By loading a sample file, G05A.trj, molecular structure at first step(Fig3.58) is 

displayed. Clicking on the  button lets the trajectory of molecular structure 

display.  The Molecular structure at the last step is shown in Fig3.59. 

 

Fig3.58 Molecular structure at the first step 

 

Fig3.59 Molecular structure at the last step 
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3.7.2. Si8 

By loading a sample file, dyna_pot_test.tr2. Nano scale device simulation team of 

Frontier Simulation Software for Industrial Science provided this result. This is Si8 MD 

calculation result. It edits every ten steps for this display example. The vector expresses 

the force in which it is influence on an atom. Please specify [Model(Atom)]-[Wire Frame], 

Model(Atom)→Wire Frame、Preference→Set Preferences→Arrow(Trajectory) arrow 

scale property is 10 in preference dialog. The first step is shown in Fig3.60. Clicking on 

the  button lets the trajectory of the vector animation. The last step is shown in 

Fig3.61. 

 

 

Fig3.60 The first step of vector example. 
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Fig3.61 The last step of vector example. 

 

3.7.3. Create a movie file of trajectory 

This section explains ho to make a movie file by using FFmpeg that is free software. 

１) Open file 

Open a trajectory file by selecting File→Open. In this case, when Trajectory file is 

selected with Files of Type, it becomes easy to choose filing because only trajectory 

file is displayed in the list. After load the file, popup the trajectory window. 

２) Specify options 

If you want to add color by fragment, select Color→fragment menu on main window.  

Set resolution options of Ball, Stick, CPK and Tube to 64 by Preference 

menu(Preferences→Set Preference→Resolution), It becomes nice to visualize a 

molecular model. By selecting Disable at Preferences →Display Axis、then the xyz 

axis at lower/left in window disappear. 

３) Create image files 

Specify the folder that is saved image files (File→Create image files menu) Format 

of images is JPEG. Convention of file name is sequential number for six digits.  

４) Prepare to create a movie file 

The source code of FFmpeg can be downloaded from http://ffmpeg.org/. The 

executable file for windows can be downloaded from http://blog.k-tai-douga.com/.  

http://ffmpeg.org/
http://blog.k-tai-douga.com/
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Copy ffmpeg.exe to C:¥Program Files¥ffmpeg, the copied folder is added to the 

end of PATH like bellow.  

   ;C:¥Program Files¥ffmpeg 

It is useful to execute the ffmpeg without specified install folder. 

５) Create a movie file 

Please type in bellow command at the folder that is stored image files by using 

command prompt. It is easy to change folder to drag the folder from explorer. 

 

ffmpeg -r 75 -i "image%06d.jpg" -vcodec wmv2 -sameq -s 640x480 

out_r75_640x480.wmv 

 

-r 75 ：set frame rate（frame per 1 second） to 75（default value is 25）.  

-i "image%06d.jpg"： Spceify image file name. %06d means sequential 

number for six digits.  

-vcodec wmv2：set Windows Media Video as codec. If you specify mjpeg or 

mspeg4v2(MS-MPEG4), according to PC you can not play this file on PowerPoint. So 

you may not specify this option. 

-s 640x480: Specify size of screen 640x480. if not specify this option, output size 

is same size of input. You had better specify this option if input size is bigger. 

Because it puts a strain in CPU.  

-sameq：Image quality of output is same quality as input.  

out_r75_640x480.wmv： output file name  

 

  ffmpeg -h > ffmpeg.txt  : output help 

  ffmpeg -formats > formats.txt : output format 

 

６) Attach a movie file on PowerPoint 

Select menu Insert→Video→File.  

It is only to link the file, so if you copy the PowerPoint file, you have to copy the 

movie file with it.  

 

Reference 

1) http://opensourceaki.blogspot.com/2007/10/ffmpeg_19.html 

2) 原一浩、寺田学、本間雅洋、足立健誌、堀内康弘、堀田直孝、月村潤、尾花衣美、FFmpeg

で作る動画共有サイト（毎日コミュニケーションズ、2008） 
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3.8. Example of crystal 

Load the Gaussian Cube file that includes the atomic structure of a Bi super-thin film 

(four layers), and the electron density in order to visualize an isosurface and a periodic 

display. Nano scale device simulation team of Frontier Simulation Software for 

Industrial Science provided this result.  

3.8.1. Load a file and visualize the isosurface 

Load a sample file(4LBi.cube) and choose Density for the file type because this file 

includes electron density data. Next, set Ball&Stick to the mode, isosurface value to 

0.009, transparency to 50 and Bonding box to on. The dialogs and the result display are  

shown in Fig3.62～Fig3.64. 

 

 

 

Fig3.62 File type dialog 

 

Fig3.63 Isosurface dialog 

 

 

Fig3.64 Example of isosurface of electron density 
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3.8.2. Periodic display 

By selecting [Viewpoint]-[Periodic], popup a dialog box to specify periodic options. Ｔｈe 

example file is Gaussian Cub, so there are a three input fields for each X,Ｙ and Z 

Interval. The value from the file is specified by the default. Ｘ and Ｙ Nums are to 2, 

and clicking Draw button. Then each direction X and Y is displayed two times. The color 

of bounding box is to cyan. A display result is shown in Fig3.65 

 

Fig3.65 Example of periodic display 

3.8.3. Display a section 

By clicking Set button on the isosurface dialog box, pop up the section dialog and display 

a half-transparent section on 3D window. Move a position of Z direction a little by slider 

and set Color Range Min to 1.0E-3. By clicking Draw Button, a section displayed.  
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Fig3.66 Section dialog and example of section 

Next, set Type to Line, Number of lines to 32. By clicking Draw button, isolines are 

displayed.  

 

Fig3.67 Example of isolines 
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Set Type to Fringe, Color Min to 1e-3. Since the way to add colors to the section and the 

isosurface is same, color of them is the same. 

 

Fig3.68 Example of isosurface colored by minimum and maximum value 
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3.8.4. Display bond 

By selecting [Preference]-[Set Preference], pop up a dialog box to specify preference. 

Set Scale of Connect Atom to 1.1, select Covalent , set resolution of balls to 16. By 

clicking Apply button, atom bonds appear and the atom rendering is smooth. 

 

Fig3.69 Change connect scale and ball resolution 
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3.9. Example of CHPI 

CHPI27) is developed by Dr. Umezawa(Microbial Chemistry Research Center)、Dr. 

Nishio(CHPI Institute) and Microbial Chemistry Research Foundation. If you write 

a paper by using this function, please describe to refer No.27. BioStationViewer 

supports to edit parameters, execute program and display result. Please refer the 

book “The CH/π Interaction” about detail of CH/π Intereaction.  

At first load PDB file, and select Tool→CHPI then popup CHPI Dialog.  

If you use default parameters, just clicking the “Execute CHPI Program” button, 

to execute the program and display result. Explain parameters as below. 

 

3.9.1. Method for exploring XH/π contacts  

 

Fig3.70 Method for exploring XH/π contacts 

  Method for exploring XH/π contacts (the six-membered aromatic ring is shown as an 

illustrative example). (a) O: centre of the π-plane. A
1
 and A

2
: nearest and second nearest 
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2
-atoms, respectively, to the hydrogen H. : dihedral angle defined by A
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(H/J). (b) Regions to be searched. 

Region 1: zone where H

 

is above the ring. Regions 2 and 3: zones where H is out of region 1 

but may interact with the π-ring. Unless otherwise noted, the program was run to search for 

short H/π contacts with the following conditions: Dmax = 3.05 Å; Dpln < Dmax (region 1); Dlin < 
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3.9.2. Edit parameter 

The dialog is shown in Fig3.71. Specify input parameters.  

 

 

Fig3.71 Input parameter dialog 

It explains the behavior of File menu. 

1) Open 

Open parameter file and those parameters is set in GUI. The file that specified at 

Pi-system loaded and set PI Information tab.  

2) Save 

Save parameters.  

3) Set Default Value 

Set default value. PDB File set displayed file at 3D view. Pi-system Table is set as  

“PDB filename.vpi”, and if this file exists load this file as PI Information. If this file 

dose not exist, default value is set. 

4) Close 

Close the dialog. 
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It explains input parameters. 

1) PDB File 

Specify the PDB file to be analyzed. 

2) Pi-system Table 

Specify the PI information file. By clicking the Edit button, PI Information dialog is 

popup.  

3) H/pi interactions 

Specify the output file. 

4) Co-ord. of H/pi interaction atom 

Specify the coordinate file.  

5) Residue & atom to delete[A7] 

Specify the atom and residue name that dose not analyzed. Please input ”END” at 

last line.  

6) Distance from hydrogen to pi center 

Specify the range of distance(Dcent) from H and center of the ring(O). Please do not 

change usually. 

7) H/pi distance from hydrogen to pi-system 

Specify the range of region1(Dmax) 

8) OMEGA<127.5(deg), ALPHA(Hangle)<６３(min63~90)(deg) 

Specify ω and α. Please do not change usually. 

9) Type of ALPHA(Hangle):H-X-R 

Specify the H-X-R angle [R=pi_plane, line(A1-A2), A1(closest pi_atom)]．Defilt is a).  

a) region1~3: R=pi_plane All region use H-X-pi_plane（=α） 

b) region1: R=pi_plane,region2:R=line,region3: R=A1  

c) region1~3:R=A1  use H-X-A1 for all region. 

10) Type of display for CHpi contacts 

Specify contact coordinate on pi plane 

a) region1: pi_plane (Dpln), region2: line (Dlin), region3: A1 (Datm) 

b) region1~3: A1 (Datm) 

c) region1~3: O (Dcent) 

a)  b)  c)  
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11) Type of interactions 

Specify type of interactions. The distinction of inter/intra is distinguished in chain 

ID of the PDB file.  

12) Type of regions 

Specify type of regions. 

13) Type of XH(NXATM) 

Specify the atom.  

14) H-pi network 

Specify output H-pi network on/off  

15) Execute CHPI Program 

Execute CHPI program by clicking this button. 
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3.9.3. Edit PI Information file 

Cliking the button of Edit at Pi-system Table, the dialog is popuped. It is shown in 

Fig3.72.  

 

Fig3.72 PI Information panel 

The file format  

 ID unique name 

 Residue name Specify residue name that are in PDB. 

 K Specify the component number in residue.  

 L Specify the serial number in one component . 

 M Specify number of ring element in component at first line only .  

 VPI Specify FIV/SIX/OLE 

 N Specify number of atom in ring element. 

 1-6 Specify atom name in ring element. 
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The example of editing PI information is shown.  

Clicking the suitable atom(C18) in 3D view and select Tool→Display Residue in 

Distance. Specify 10Å at the dialog. Select Tool→Set Rotation Center(Fig3.73). So 

displayed around C18 and set center of spinning. 

 Clicking STU at Tree view by right button on mouse, popup the display attribute 

dialog. Specify Color(Atom) and Model(Stick). (Fig3.74) 

 

 

Fig3.73 Select “Display Residue in Distance” and “Set Rotation Center”  

 

Fig3.74 Set Model and Color of STU by clicking right button of mouse 
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It explains the behavior of each button. 

1) Highlight selected atoms in 3D viewer 

The selected Atoms in 3d viewer is shown highlighted.  

 

2) Add a atom name that picked in 3D viewer 

If you select “On”, insert atom name at cursor position.  
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Explain the File Menu.  

1) Open 

Open PI Information file and those parameters is set in GUI.  

2) Save 

Save PI Information. 

3) Set Default Value 

Set default value. Information on the fixed form on amino acid, DNA, and RNA is 

set. Besides, it is set recognizing the ring of the part of HEM of the PDB file 

specified with PDB File at Input Data tab. ID is set as XXX. It is generated one 

element from some rings. The user can edit it. The example of 

1qpj_CHminCFFAB.pdb is shown below.  

 

Fig3.75 Default PI information of 1qpj_CHminCFFAB.pdb 

4) Close 

Close this dialog.  
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3.9.4. Execute program 

Clicking by the “Execute CHPI Program” button, then to start to execute CHPI program 

at Command Prompt. The Execute log is shown in it. 

 

Fig3.76 Command prompt of CHPI execution 

When end the program, to close the command prompt. Then result is displayed in 3D 

view. One interaction is named as CHPIn（n:serial number）, By clicking CHPI on 3D 

view, then display distance of this interaction at message area. The example is shown in 

Fig3.77, Fig3.78 and Fig3.79. 

 

Fig3.77 Result of CHPI(Click CHPI75) 
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Fig3.78 Change preference (Model : Line Solid, Color : blur) 

 

Fig3.79 The residue that is around the ligand displayed by Stick Model. 
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4 Tutorials 

4.1 Intermolecular Interactions in (Gly)10 

This section reports a example of (Gly)10 IFIE analysis. The fragmentation is 1 

fragment / 1 residue. Calculations were performed at the FMO-HF level with STO-3G. 

 

4.1.1. Modeling 

Start the viewer and select File→Molda then popup Molda window. By Selecting Model

→input→Peptide, popup Peptide Dialog. Type in “g”(short name of Glycin) ten times 

and click “OK” button so structure of (gly)10 is displayed on Molda window. The input 

dialog is shown in Fig4.1. 

 

 

Fig4.1 Peptide dialog 

And select menu File→Displaｙ→To Vieｗer to copy this structure to viewer. It is 

displayed to Viewer by the file name of molda_tmp.pdb. 
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4.1.2. Structure Optimization 

There is this file in a current folder that starts Viewer. Change file name to gly10.pdb,  

close molda_tmp.pdb on main window by selecting menu File→Close File and load 

gly10.pdb by selecting menu File→Open.  

 Select Tool→Hydrogen Capping Mode, mark Terminal and COOH NH2 on dialog as 

Hydrogen Capping Mode, then click the OK Button.  

 

Specify Hydrogen Capping Mode 

 

Fig4.2 Structure Gly10 after hydrogen capping 
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By selecting menu Tool→Optimize structure then popup the structure optimize 

dialog(Fig4.3). Specify three file names, Hydrogen Options, Optimize Options and  

input file name.  

 

Fig4.3 Structure Optimize dialog 

By clicking the OK button, execute structure optimize and display result structure on 

main window. The result file name is gly10_H_opt.pdb, it is added _H_opt on input file 

name. The options are shown below. Please refer section 5 about the detail of options. 

The methodology of optimize is an eXtended Universal Force Field Universal Force 

Field (XUFF). This is our own program. 

 

gly10_Hydrogen.par 

 

gly_Optimize.par 

 

 

4.1.3. Calculation 

By Selecting menu [File]→[Edit ABINIT-MP Input File] then popup the parameters for 

input file window. Input parameters, save a input file and execute ABINIT-MP by using 

this file. 

-B 
-R 
 

-O 
-h 
OPTIMIZATION 100 
SDLOOP 100 
MAXLOOP 500 
SDGRADIENT 1000.0. 
CGGRADIENT 0.1  
RGRADIENT 0.1 
RENERGY 0.0001 
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 Please modify Read Geometory File and Write Geometory to real file names on 

execution machine. The parameters are show in below. 
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Fig4.4  Parameters 

4.1.4. Result 

We show 2 case results. 

１) Molecular structure is optimized by XUFF(apply to Hydrogen atoms) 

２) No optimizeｄ structure. It is just modeling by Molda. 

The hydrogen bond appears every 3 fragments in α-Helix, so it shows IFIE is stable 

reaction between the fragmentations nth and n+3th. When you compare with two results, 

they show more stabilized (approximately 0.4 kcal/mol)) by optimizing for the hydrogen 

atoms at hydrogen bond.  

 

(1) Result 1 : Molecular structure is optimized by XUFF(apply to Hydrogen atoms) 

Total energy 

  ========================= 

     ## FMO TOTAL ENERGY 

  ========================= 

        Nuclear repulsion =      5342.1817591836 

        Electronic energy =     -7458.3751057039 

        Total      energy =     -2116.1933465204 

 

IFIE 

Table 4.1 IFIE : molecular structure is optimized by XUFF (FMO-HF/STO-3G) 

  Gly1 Gly2 Gly3 Gly4 Gly5 Gly6 Gly7 Gly8 

Gly1         

Gly2         

Gly3 0.72        

Gly4 0.46 1.44       

Gly5 0.81 -4.66 1.85      

Gly6 0.61 -2.48 -4.85 1.95     

Gly7 0.24 -0.24 -2.40 -4.73 1.75    

Gly8 0.14 -0.16 -0.21 -2.39 -4.72 1.92   

Gly9 0.11 -0.26 -0.16 -0.22 -2.47 -4.94 1.84  

Gly10 0.10 -0.23 -0.41 -0.23 0.00 -2.54 -7.71 5.15 
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(2) Result 2 : No optimized structure  

 

Total energy 

  ========================= 

     ## FMO TOTAL ENERGY 

  ========================= 

        Nuclear repulsion =      5352.4874175133 

        Electronic energy =     -7468.6560823049 

        Total      energy =     -2116.1686647916 

 

(IFIE) 

Table 4.2 IFIE : No optimized structure (MO-HF/STO-3G) 

  Gly1 Gly2 Gly3 Gly4 Gly5 Gly6 Gly7 Gly8 

Gly1         

Gly2         

Gly3 1.77        

Gly4 0.77 1.53       

Gly5 0.54 -4.27 1.47      

Gly6 0.55 -2.46 -4.43 1.56     

Gly7 0.27 -0.27 -2.41 -4.34 1.48    

Gly8 0.15 -0.17 -0.25 -2.41 -4.29 1.64   

Gly9 0.08 -0.25 -0.17 -0.26 -2.49 -4.47 1.57  

Gly10 0.10 -0.23 -0.40 -0.24 -0.01 -2.55 -7.30 5.04 
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5 Super molecule  

This section describes that the formula of supermolecule calculation. 

In case of the supermolecule calculation by FMO Method, the Complex 

Fragmentation simply consist of protein and ligand.(C:Complex P:Protein L:Ligand → 

C= P∪L). Each energy described to Complex total energy : EC、Protein total energy : EP、

Ligand Protein total energy : EL. The Interaction Energy between protein and ligand:Δ

E was given by  

)( LPC EEEE          (exp 5.1) 

Supposing 
LPC EEE ,, were calculated by FMO2, ΔE was given by 
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( 'E : Monomer energy excluding contribution from environmental electrostatic potential, 

IJE
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 : Inter-fragment interaction energy） If 
CE is decomposed into the term that inner 

protein, inner lgand and intermolecule protein-ligand, 
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and pack terms of protein and ligand.  
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ΔE is given by 



199 


 











































PI
I

LJ
J

C

IJ

LJI
JI

IJ

LI
I

I

PJI
JI

IJ

PI
I

I EEEEEE
~~~

,,

 (exp 5.6) 

The first term is stabilization energy by electronic relaxation of protein that given by 

binding protein and ligand. The second term is stabilization energy by electronic 

relaxation of ligand. The third term is IFIE of between protein and ligand. 

 In Viewer, read each CPFs(complex, protein and ligand), and specified corresponding 

fragmentation number in that. 

 Next describes the concrete calculation method which calculates super molecule value 

from IFIE and momomer value. 

1) Step１ calculation of 
IE'  

Subtract complex from protein and ligand at monomer value.  

 

図 5.1 Memory image of IJE  

2) Step２ calculation of IJE
~

  

Subtract complex from protein and ligand at IFIE  

 

図 5.2  Memory image of IJE
~
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3) Step3  calculation of Supermolecule IFIE 
'~C

IJE  

Calculate Supermolecule IFIE using Step1 and Step2 results.  

Protein ： 
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1
     (exp 5.7) 

Logand  ： 
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図 5.3  Memory image of  IJE
~

 

Each half of the changed portion of IFIE values by electronic relaxation inner protein is 

restored to each fragmentation at the second term of (exp 5.7). The ligand is the same at 

(exp 5.8).  

The Protein – ligand IFIE analysis that regards the effect of the electronic relaxation by 

protien – ligand binding in fragment unit becomes possible by this calculation result. 
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6 Option of optimize structure 

The Structure optimization is executed by calling another program from Viewer. Here, 

the option that can be specified is shown below. The file that describes this option is 

prepared, and it specifies it on the screen of the structure optimization. 

 

Hydrogenation of 

protein (arbitrariness) 

-B 

The calculation of Atom type is specified. 

-n 

Addition of hydrogen atom (When -B is specified, it is effective). 

When you add hydrogen : No filling in 

When you do not add hydrogen : -n 

Specification of 

structure optimization 

(arbitrariness) 

 

-O 

Execution of structure optimization by XUFF force field. 

 When you do the structure optimization calculation : -O 

  When you do not do the structure optimization calculation 

      : No filling in 

 

-X # 

The optimization calculation loop interval of the charge 

recalculation by the MQEq method (when -O is specified, it is 

effective) is specified by positive integer #. 
 

-h 

Optimization of atomic site of hydrogen (when -O is specified, it is 

effective). It is assumed that ACTIVE shown by the following was 

specified for all the hydrogen atoms and processes it. It is assumed that 

INACTIVE shown by the following was specified for all atoms except 

the hydrogen atom and processes it. 

 

-S 

A heavy atomic location of a main chain is fixed. Optimization of side 

chain structure and atomic site of hydrogen (when -O is specified, it 

is effective). It is assumed that ACTIVE shown by the following was 

specified for all atoms except a heavy atom of a main chain and 

processes it. It is assumed that INACTIVE shown by the following was 

specified for all heavy atoms of a main chain and processes it. 

 

The method of recognizing a main chain in the PDB form and the 

MOL2 form is as follows. 

 

Main chain of PDB form :  

Atom name 

N 

CA 

C 

O 

OXT 
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Main chain of MOL2 form :  

Atom name Atom type 

N N.4或いは N.am 

CA C.3 

C C.2 

O O.2 

OXT O.3 

 (The one to fill both) 

 

-T 

Processing of N end and C end. 

When you dissociate N end and C end : -T 

    (NH4+, COO-) 

When you dissociate neither N end nor C end : No filling in 

    (NH3, COOH) 

 

-R 

Processing ASP, GLU, LYS and ARG. 

When you specify the charge state : -R 

When you specify the state of the neutral : No filling in 

 

-H # 

Processing of imidazole ring of histidine (Default is π type). 

    π type (d type) : -H d 

    τ type (e type) : -H e 

    ｐ type (p type) : -H p 

 

-C # c 

All charges of each molecule are specified. 

# : Number of molecule 

c : charge 

In default, all charges of each molecule are zero. 

The method of distinguishing the molecule in the PDB form and the 

MOL2 form is as follows. 

 

Distinction of molecule of PDB form : (Uncorrespondence of part) 

It confirms it in order of TER, HETATM, a molecular name (residue 

name), and the residue number. In the following cases, the molecule 

is changed. 

・ When TER appears. 

・ When HETATM appears. 

・ When a molecular name in HETATM is changed (A molecule 

that is smaller than about five atoms is excluded. The water 

molecule is excluded.). 

・ When changing from HETATM into ATOM. 
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・ When the residue number becomes small 

 

Distinction of main chain of MOL2 form :  

Information on following Substract id and Substract name is used 

and distinguished. 

Substract id : Given integer of amino-acid residue and each low 

molecular weight compound. It is counted in 

ascending order. 

Substract name : Name of amino-acid residue and compound. Even 

when Substract id is not changed, this Substract 

name is changed if a different low molecular 

weight compound is continuously specified. 

 

-k [Tinker_key_file] : The Keyword Control file of the Tinker form is 

specified (When -O is specified, it is effective.). 

   The default name is tinker.key. 

 

Whether each atom is ACTIVE or INACTIVE can be specified. 

Example) ACTIVE 4 -9 17 23 

When atoms 4, 9-17, and 23 are calculated, it is activated. Minus 

(-) means the start of the range. Two or more ACTIVE can be 

specified. Two or more INACTIVE can be still specified in the 

meaning opposite to actively. However, when the same atoms 

are specified for both ACTIVE and INACTIVE, it becomes 

ACTIVE. The atom not specified even for any ACTIVE and 

INACTIVE becomes ACTIVE.  

 

-f [xuffopt_parameter_file] 

   [xuffopt_parameter_file] : The file of the parameter of xuffopt 

original form is specified. Options other than -f, the following total 

conditions ACTIVE_RESIDUE, INACTIVE_RESIDUE and 

ACTIVE_SIDECHAIN concerning the amino-acid residue, and 

conditions SDLOOP, CGLOOP, MAXLOOP, SDGRADIENT, 

CGGRADIENT, RENERGY and RGRADIENT concerning the 

convergent calculation of the optimization loop can be specified. 

The default name is xuffopt.par.  

 

Whether each amino-acid residue is ACTIVE_RESIDUE or 

INACTIVE_RESIDUE can be specified. The specification method is 

the same as ACTIVE and INACTIVE. 

Example) ACTIVE_RESIDUE 4 -9 17 23 

When residue 4, 9-17, and 23 are calculated, it is activated. 

Minus (-) means the start of the range. Two or more 

ACTIV_RESIDUE can be specified. Two or more 

INACTIVE_RESIDUE can be still specified in the meaning 

opposite to actively. However, when same residue are specified 

for both ACTIVE_RESIDUE and INACTIVE_RESIDUE, it 

becomes ACTIVE_RESIDUE. The residue not specified even 

for any ACTIVE_RESIDUE and INACTIVE_RESIDUE 
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becomes ACTIVE_RESIDUE. 

 

ACTIVE_SIDECHAIN can be specified for the side chain of 

each amino-acid residue (parts except a main chain). The 

specification method is the same as ACTIVE and 

ACTIVE_RESIDUE. 

 

The settling calculation frequency and the settling judgment condition 

of the optimization loop can be specified (The following examples are 

the default values). 

 Example) 

SDLOOP  100 

   CGLOOP  400 

   MAXLOOP  500 

   SDGRADIENT  1000.0 

   CGGRADIENT  0.1 

   RGRADIENT  0.1 

   RENERGY  0.0001 

 

SDLOOP : Number of maximum Steepest Descent law loops 

(SD loop)  

CGLOOP : Number of maximum Conjugate Gradient law loops 

(CG loop)  

LOOPMAX : Number of maximum loops 

SDGRADIENT : Gradient discontinuance value of SD loop 

CGGRADIENT : Gradient discontinuance value of CG loop 

RGRADIENT : Tolerance for convergence of Gradient 

RENERGY : Tolerance for convergence of rest error (kcal/mol) of 

all energy 

 

Gradient is judged by the value of the second power harmony route. 

The unit is (kcal/mol･Å). The CG loop continues to "Number of 

maximum SD loops + number of maximum CG loops" when the SD 

loop is discontinued on the way.  

Because the BFGC method is not being calculated now, CGLOOP 

and CGGRADIENT are invalid. 
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7 Installation 

7.1 Distribution 

We have a windows installer file. 

7.2 System Installation 

Double-clicking install file icon then installs it. To execute the viewer by selecting menu 

that is start→ABINIT-MP Open Consortium→BioStationViewer. 

The wroking folder is install folder. You can change it to change property of menu item 

and add a install path to PATH like bellow. 

C:¥Program Files¥ ABINIT-MP Open Consortium ¥BioStationViewer 

 

7.3 System Requirements 

System Requirements is shown in Table 7.1.  

Table 7.1 System Requirements 

Item Business 

OS Windows(2000/XP,7) 

CPU Pentium Ⅱ  400MHz or more 

Memory Recommended memory 2GB or more 

 

7.4 File Acquisition 

Obtain Biostation Viewer files from a web site of ABINIT-MP. The following files needs 

to run Biostation Viewer. 

File name Explanation 

BioStationViewerOpen_1.0_rev25.exe  BioStation Installer file 

sampleData.zip Sample files 

tutrial.zip Tutorial data files 

 

7.5 Reduce 

You can use Reduce in order to add hydrogen.  Reduce can be downloaded from 

http://kinemage.biochem.duke.edu/software/software2.html#reduce 

, which is a program free of charge.   

Download the program and save it to the appropriate place.  Set Path to the folder, 

then.  Refer to the preceding paragraph so as to set Path.  Options are shown as 

follows. 

 

reduce: version 2.15 10/4/01, Copyright 1997-2001, J. Michael Word 

http://kinemage.biochem.duke.edu/software/software2.html#reduce
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arguments: [-flags] filename or - 

 

Adds hydrogens to a PDB format file and writes to standard output. 

(note: By default, HIS sidechain NH protons are not added. See -BUILD) 

 

Flags: 

-Trim             remove (rather than add) hydrogens 

 

-NOOH             remove hydrogens on OH and SH groups 

-OH               add hydrogen on OH and SH groups (default) 

 

-HIS              create NH hydrogen on HIS rings 

-FLIPs            allow complete ASN, GLN and HIS side chains to flip 

                        (usually used with -HIS) 

-NOHETh           do not attempt to add NH proton on Het groups 

-ROTNH3           allow lysine NH3 to rotate (default) 

-NOROTNH3         do not allow lysine NH3 to rotate 

-ROTEXist         allow existing rotatable groups (OH, SH, Met-CH3) to rotate 

-ROTEXOH          allow existing OH & SH groups to rotate 

-ALLMEthyls       allow all methyl groups to rotate 

-ONLYA            only adjust 'A' conformations (default) 

-ALLALT           process adjustments for all conformations 

-NOROTMET         do not rotate methionine methyl groups 

-NOADJust         do not process any rot or flip adjustments 

 

-BUILD            add H, including His sc NH, then rotate and flip groups 

                  (except for pre-existing methionine methyl hydrogens) 

                  (same as: -OH -ROTEXOH -HIS -FLIP) 

 

-Keep             keep bond lengths as found 

-NBonds#          remove dots if cause within n bonds (default=3) 

-Model#           which model to process (default=1) 

-Nterm#           max number of nterm residue (default=1) 

-DENSity#.#       dot density (in dots/A^2) for VDW calculations (default=16) 

-RADius#.#        probe radius (in A) for VDW calculations (default=0) 

-OCCcuttoff#.#    occupancy cutoff for adjustments (default=0.01) 
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-H2OBcuttoff#.#   B-factor  cutoff for water atoms (default=40) 

-H2OOCCcuttoff#.# occupancy cutoff for water atoms (default=0.66) 

-PENalty#.#       fraction of std. bias towards original orientation (default=1) 

-HBREGcuttoff#.#  over this gap regular HBonds bump (default=0.6) 

-HBCHargedcut#.#  over this gap charged HBonds bump (default=0.4) 

-BADBumpcut#.#    at this gap a bump is 'bad' (default=0.4) 

-SEGIDmap "seg,c..."  specify chainID based on segment identifier field 

-Xplor            use Xplor conventions for naming polar hydrogens 

-NOCon            drop connect records 

-LIMIT#           max num iter. for exhaustive search (default=100000) 

-NOTICKs          do not display the set orientation ticker during processing 

-SHOWSCore        display scores for each orientation considered during processing 

-FIX "filename"   if given, file specifies orientations for adjustable groups 

-DB "filename"    file to search for het info 

                        (default="/usr/local/reduce_het_dict.txt") 

note: can also redirect with unix environment variable: REDUCE_HET_DICT 

 

-Quiet            do not write extra info to the console 

-REFerence        display citation reference 

-Help             more extensive description of command line arguments 

 

7.6 Babel 

Set BABEL_DIR(Environment Parameter) 

C:¥Program Files¥ ABINIT-MP Open Consortium ¥BioStationViewer¥babel-lis 
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7.7 Bond Builder 

The use of “bond_builder” which is the hydrogenation program is shown in Table 7.2. 

 

Table 7.2  Explanation of the use of “bond_builder”. 

Command line % bond_builder.exe –i [input_file_name] [input_file_type] 

 –o [output_file_name] [output_file_type] 

–B –n –T –R –H # 

Setting of the input file –i [input_file_name] [input_file_type] 

[input_file_name] : Input file name (indispensable). 

[input_file_type] : Type of the input file (arbitrariness). 

pdb, ent : For the type of PDB 

mol2 : For the type of mol2 

Default file type is decided by the extension of the input file name. File 

type is PDB in the case of pdb or ent , and mol2 in the case of mol2. 

Setting of the output file –o [output_file_name] [output_file_type] 

  [output_file_name] : Output file name. 

[output_file_type] : Type of the output file (arbitrariness). 

pdb, ent : For the type of PDB 

mol2 : For the type of MOL2 

Default file type is decided by the extension of the output file name. 

File type is PDB in the case of pdb or ent , and mol2 in the case of 

mol2. 

When “－o” is not specified, the file name that adds “_builder” to the 

input file name is output. example) input_builder.mol2 

At this time (“-o” is not specified), when “-B” (see below) is specified, 

the file name that adds “_H” to the input file name is output. example) 

input_H.pdb 

Hydrogenation of protein 

(arbitrariness) 

–B 

 The calculation of Atom type is specified. 

–n 

Addition of hydrogen atom (When -B is specified, it is effective). 

When you add hydrogen : No filling in 

When you do not add hydrogen : -n 

Processing of N terminal 

and C terminal of the 

protein 

(arbitrariness) 

–T 

When you dissociate N terminal and C terminal : -T 

    (NH4+, COO-) 

When you dissociate neither N terminal nor C terminal : No filling in 

    (NH3, COOH) 

Processing of charged 

residues ASP, GLU, 

LYS and ARG 

(arbitrariness) 

–R 

When you specify the charge state : -R 

When you specify the state of the neutral : No filling in 

Processing of imidazole 

ring of histidine 

(Default is π type) 

–H # 

  π type (d type) : -H d 

  τ type (e type) : -H e 

  ｐ type (p type) : -H p 
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7.8 TINKER 

Download from http://dasher.wustl.edu/tinker/, and add Path (install folder/bin). Copy 

install folder/ｊre/bin/client/jvm.dll to bin.  

 

http://dasher.wustl.edu/tinker/
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